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Introduction to the Module 

This unit covers the knowledge, skill and attitude required to apply geographic information 

systems (GIS) software to prepare digital data, produce maps and resolve problems using 

spatial and non-spatial data based on organizational standards. 
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   LG#33 LO #1- Definition, concepts and basic 

functions of a GIS 

 

Instruction sheet 1 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Definition and concepts of GIS 

 Key elements of GIS 

 Components of GIS 

 Basic functions of GIS 

 GIS for cadaster application 

 Basics of spatial data  

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Definition and concepts of GIS 

 Identify Key elements of GIS 

 Describe Components of GIS 

 Basic functions of GIS 

 GIS for cadastre application 

 Basics of spatial data  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below. 

3. Read the information written in the information Sheets 

4. Accomplish the Self-checks  

5. Perform Operation Sheets 

6. Do the “LAP test”  
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Information Sheet -1 

1.1. Definition and concepts of GIS 

We humans are confined in our activities to the surface and near-surface of the Earth. We 

travel over it and in the lower levels of the atmosphere, and through tunnels dug just below 

the surface. We dig ditches and bury pipelines and cables, construct mines to get at mineral 

deposits, and drill wells to access oil and gas. Keeping track of all of this activity is 

important, and knowing where it occurs can be the most convenient basis for tracking (Paul 

A. Longley, 2004). Knowing where something happens is of critical importance if we want to 

go there ourselves or send someone there, to find other information about the same place, or 

to inform people who live nearby. Because location is so important, it is an issue in many of 

the problems society must solve. Some of these are so routine that we almost fail to notice 

them – the daily question of which route to take to and from work. Problems that involve an 

aspect of location, either in the information used to solve them, or in the solutions 

themselves, are termed geographic problems. Here are some more examples:  

 Land administration authorities solve geographic problems when they allocate lands 

for farm or industry purposes.  

 They solve boundary conflicts to allocate the right holders. Our world is dynamic. 

Many aspects of our daily lives and our environment are constantly changing, and not 

always for the better (ITC, 2009). There is always a conflict on the environment 

between natural world and man world. This needs a serious management to have fair 

and just resource distributions among communities. 
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Figure 1. 1. Relationship between natural world and manmade world 

A Geographic Information System (GIS) - is a tool for making and using spatial information. 

It uses the power of computer to pose and answer geographic questions. The user guides the 

program to arrange and display data about places on the planet in a variety of ways - 

including maps, charts and tables. The hardware and software allows the users to see and 

interact with data in new ways by blending electronic maps and databases to generate color-

coded displays. Users can zoom in (enlarge) and out of (reduce) maps freely; add layers of 

new data, and study detail and relationships. Geographic Information System (GIS): is an 

organized collection of computer hardware, software, geographical data, and personnel 

designed to efficiently capture, store, update, manipulate, analyze and display all forms of 

geographically referenced data (Fazal.S, 2008). Therefor Comprehensive GIS require a 

means of:  

 Data input, from maps, aerial photos, satellites, surveys, and other sources.  

 Data storage, retrieval, and query.  

 Data transformation, analysis, and modeling, including spatial statistics.  
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 Data reporting, such as maps, reports, and plans 

Some key concepts in GIS include: 

1. Spatial data: GIS is based on the concept of spatial data, which refers to data 

that has a geographic location or spatial context. This can include data about 

physical features, such as elevation or land cover, as well as data about human 

activities, such as population density or transportation networks. 

2. Geocoding: Geocoding is the process of assigning geographic coordinates, 

such as latitude and longitude, to spatial data. This allows the data to be 

located and analyzed within a spatial context. 

3. Spatial analysis: Spatial analysis involves using GIS tools and techniques to 

analyze spatial data and gain insights into spatial relationships and patterns. 

This can include techniques such as spatial clustering, interpolation, and 

network analysis. 

4. Map visualization: GIS allows users to create maps that visualize spatial data 

and provide a visual representation of complex spatial relationships and 

patterns. Maps can be customized and tailored to specific needs and can be 

used to communicate information and insights to a variety ofusers. 

5. Data integration: GIS allows users to integrate data from a variety of sources 

and formats, including satellite images, aerial photos, GPS data, survey data, 

and demographic data. This integration of data from different sources can 

provide a more comprehensive understanding of spatial relationships and 

patterns. 

6. Data management: GIS involves managing spatial data in an organized and 

efficient manner. This can include data storage, data retrieval, data backup and 

archiving, and data security. 

GIS is a powerful tool for managing and analyzing spatial data. It provides a way to 

integrate and analyze data from a variety of sources and formats, and to gain insights 

into complex spatial relationships and patterns. GIS is used in a variety of 

applications, including urban planning, natural resource management, emergency 

management, public health, and many others. 
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1.2. Identify Key elements of GIS 

As it is explained in section 1.1, GIS is an acronym representing for Geographic Information 

System. These three words in GIS are called elements of GIS and can be explained in the 

following paragraphs. 

 

Figure 1. 2.  Key elements of GIS 

I. Geographic 

 This is the part of GIS that explains "spatially" where things are such as the location of 

nations, states, counties, cities, schools, roads, rivers, lakes, land parcels and the list can go 

on and on. Spatially means where on the earth's surface an object or feature is located. This 

can be as simple as the latitude and longitude of a feature. The geographic feature or object 

can be anything of interest.  

II. Information  

GIS information is the "data" or "attribute" information about specific features that we are 

interested in such as the name of the feature, what the feature is, the location of the feature, 

and any other information that is important. An example could be the name of a city, where it 

is located, how big it is in square feet (area), its population, its population in the past, and any 
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other information that is important. 

III. System  

The system in GIS is the computer and the software that is written to help people analyze the 

data, look at the data and combine it in various ways to show relationships or to create 

geographic models. A GIS can be made up of a variety of software and hardware tools, as 

long as they are integrated to provide a functional geographic data processing tool. 

1.3. Components of GIS 

A GIS is comprised of hardware, software, data, humans, network and a set of organizational 

protocols called method that make it possible to enter, manipulate, analyze, and present 

information that is tied to a location on the earth’s surface. For the common sense of any GIS 

application, GIS has six components such as hard ware, software, people, data and analysis 

(methods, procedures) and networks as shown in the following figure. 

 

Figure 1. 3. Components of GIS 
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I. Hardware: consists of the computer system on which the GIS software will run. It is 

the computer on which a GIS operates. example: Scanner, Printers and plotters, 

Storage devices  

II.  software: Software that is used to create, manage, analyze and visualize geographic 

data, i.e. data with a reference to a place on earth, is usually denoted by the umbrella 

term ‘GIS software’. Example, • Quantum GIS Desktop • ArcView UDig • ArcGIS 

GRASS • Manifold GIS  

III. People: are GIS users can run GIS software.  

IV. Data: The important component of a GIS is the data. Geographic data and related 

attribute data can be collected in-house or purchased from other organizations and can 

be compiled to custom specifications and requirements, or occasionally purchased 

from a commercial data provider. Example of data is: spatial and attribute data. 

V. Analysis/Procedures, methods/: how the data will be retrieved, input into the 

system, stored, managed, transformed, analyzed, and finally presented in a final 

output. 

VI. Network It refers to both the computer, and social network. Both of these networks assist in 

the dissemination of data. Where the dissemination of data is through transferring of data sets 

or collaboration, sharing the data from a GIS is a very common and useful operation. 

Additionally, these networks allow for the display of information in the form of web maps, 

web applications, or even paper maps using our social network 

 

1.4. Basic functions of GIS 

A GIS is often defined not for what it is but for what it can do. Surveyors depend on a variety 

of software and technology to gather existing information, collect new information, analyze 

data, produce plans, manage projects, and deliver accurate data. Geographic information 

system (GIS) technology brings this functionality and more to one place, providing a central 

location to conduct spatial analysis, overlay data, and integrate other solutions and systems. 

GIS is built on a database rather than individual project files, enabling surveyors to easily 

manage, reuse, share, and analyze data, saving them time. The function of GIS is mainly 

derived from its definition as you have seen in section 1.1. Thus are: 
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Figure 1. 4. Functions of GIS 

1.  Capture: For a GIS application data should be capture or/ collect from primary data 

source and secondary data sources. 

 

Figure 1. 5. Data capture 

2. Storing  

It is crucial stage in creating a geographical database using GIS. Data storage within a GIS 

has historically been an issue of both spaces usually how much disk space the system 

requires-and access, or how flexible a GIS is in terms of making the data available for use. 
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Ideally, the GIS software should be able to read common data formats for both raster (DEM, 

GIF, TIFF, JPEG, Encapsulated PostScript) and vector (CSV, TIGER, HPGL, DXF, 

PostScript, DLG).  

 

Figure 1. 6. Data storing format 

3. Updating  

GIS can help to update data. When data is:  

 Needed to change  

 Incomplete( missing data, data duplication,)  

 inaccurate ( invalid data, confused data ) 

 needed to add new fields 

4. Manipulating  

Data manipulation is the process of extracting information and applying logic to it to generate 

a completely different set of data. In other words, data is modified when manipulated and 

stored in the same location. 

5. Analysis 

 Attribute query and display  

 Map measurement ( distance, direction, area) 
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1.5. GIS for cadaster application 

GIS has many applications in the field of cadaster for managing land records and property 

information. Cadaster refers to a public record of land ownership and its boundaries. By using 

GIS in cadaster applications, governments and other organizations can better manage land 

records, make more informed decisions, and improve communication and coordination 

among stakeholders involved in land management. The use of GIS in cadaster applications 

provides many benefits, including: 

1. Improved data accuracy: GIS allows for more accurate data capture and storage, 

which can help to reduce errors in land ownership records and property information. 

2. Efficient data management: GIS provides a centralized database for storing and 

managing cadaster data, which can make it easier to access and update land records 

and property information. 

3. Spatial analysis: GIS allows for spatial analysis of cadaster data, which can help to 

identify patterns and trends in land ownership and property information. This can be 

used to inform decision-making in areas such as land use planning and zoning. 

4. Collaboration: GIS can facilitate collaboration between different stakeholders 

involved in cadaster management, such as government agencies, surveyors, and 

landowners. This can help to improve communication and coordination in the 

management of land records and property information. 

5. Visualization: GIS allows for the creation of maps and other visualizations of 

cadaster data, which can help to communicate information and insights to a variety of 

users. 

6. Integration with other systems: GIS can be integrated with other systems, such as 

property tax systems and land development systems, to provide a more 

comprehensive view of land ownership and property information. 
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Figure 1. 7. Application of GIS  

1.6.  Type of GIS data  

There are three main types of GIS data:  

1. Vector data: Vector data are represented by points, lines, and polygons. Points are used 

to represent discrete locations, such as the location of a city or a landmark. Lines are used 

to represent linear features, such as roads, rivers, or pipelines. Polygons are used to 

represent areas, such as land use, administrative boundaries, or vegetation cover. Vector 

data is often used for creating maps, performing spatial analysis, and managing 

geographic information. 

2. Raster data: Raster data are represented by a grid of cells or pixels. Each cell in the grid 

contains a value that represents a specific attribute, such as elevation, temperature, or 

vegetation density. Raster data is often used for remote sensing applications, such as 

satellite imagery, and for modeling and analysis of continuous data, such as rainfall or 

temperature. 
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3. Tabular data: Tabular data are represented by rows and columns of data, similar to a 

spreadsheet. Each row in the table represents a feature, such as a city, a parcel of land, or 

a point of interest. Each column in the table represents an attribute of the feature, such as 

population, area, or name. Tabular data is often used for managing and analyzing non-

spatial data, such as demographic information or land ownership records. 

In addition to these three main types of GIS data, there are also specialized data types that are 

used for specific applications, such as network data for transportation analysis, terrain data 

for elevation modeling, and geocoding data for address matching. It is important to choose 

the appropriate data type for each application, as different data types have different strengths 

and limitations. For example, vector data is often used for mapping and spatial analysis, 

while raster data is better suited for modeling and analysis of continuous data. Tabular data is 

useful for managing and analyzing non-spatial data, but it can also be linked to spatial data to 

provide additional context and insights. Overall, understanding the different types of GIS data 

and their applications is essential for effective data management and analysis in GIS. 
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Self-Check 1 Written test 

 

Name……………………………………………   ID………………………… Date……. 

Directions:  Answer all the questions listed below.  

Test I: Short Answer Questions  

1. Define GIS and discuss its elements.  

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 

1. Discuss the application of GIS for Cadaster.  

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 

2. Explain the function of GIS.  

----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 

3. Discuss GIS data types.  

 ----------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------- 
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   LG#34 LO #2- Digital data for GIS inputs 

 

 

 

 

 

 

 

 

 

Instruction sheet 2 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Scanning and preparing maps and field registration 

 Managing point data in different format and upload  

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Scan and prepare maps and field registration. 

 Manage point data in different format and upload  

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below. 

3. Read the information written in the information Sheets 

4. Accomplish the Self-checks  

5. Perform Operation Sheets 

6. Do the “LAP test”  
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Information Sheet -2 

 

2.1. Scanning and preparing maps and field registration forms  

2.1.1. Scanning and preparing maps 

In computing and digital imaging, scanning refers to the process of capturing an image, 

document, or other physical object and converting it into a digital format that can be stored, 

edited, and shared electronically. This is typically done using a scanner, which is a device 

that uses sensors to capture the physical characteristics of the object being scanned and 

convert them into digital data. Depending on the type of scanner and the settings used, 

scanning can capture a wide range of information about the object being scanned, including 

its color, texture, size, and shape.  

Scanning and preparing maps involves digitizing paper maps and converting them into a 

digital format that can be easily stored, managed, and analyzed. The following are some steps 

that can be taken to scan and prepare maps: 

1. Identify the maps: The first step in scanning and preparing maps is to identify the 

maps that need to be scanned. This may include topographic maps, thematic maps, or 

other types of paper maps. 

2. Determine the scanning process: The next step is to determine the scanning process. 

This may involve using a desktop scanner to scan the maps, or using a large format 

scanner to capture the maps at a higher resolution. 

3. Prepare the maps: Before scanning the maps, it is important to prepare them by 

removing any staples or paper clips and ensuring that the maps are in good condition. 

This will help to ensure that the maps are scanned accurately and are legible once 

digitized. 

4. Scan the maps: Once the maps have been prepared, they can be scanned using a 

desktop scanner or large format scanner. It is important to ensure that the scans are of 

high quality and that they capture all of the necessary information on the maps. 
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The data are stored directly on the hard drive of an interfaced computer and can be viewed on 

a screen, edited, and manipulated. Editing is an important and necessary step in the process, 

because the scanner will record everything, including blemishes, stains, and creases. It 

requires:   

2.1.1.1. Scanner preparations 

This is the way of identifying scanner specification/brand name as well as its well-being in 

order to install to a computer/PC. For this module use scanner A3 1200S, Then Install the 

Scan Express of A3 1200S (panel V-2) scanner driver in your computer/PC.  

 

 

Figure 2. 1. FA3 1200S Scanner with computer connecting driver 

When the scanner is attached with PC through the USB cable, the scanning software (panel 

V2.0) will be automatically display as you see in the above figure 7. Settings found on 

scanner software like scan mode (color), Resolution (600dpi), file path (select directory), file 

type (TIFF) should be selected when filed map is scanned. Usually the high resolution value 

should be selected among the listed value. Because resolution is a measure of how much 

image detail information the scanner is to capture in a scanner. A higher resolution results to 

a sharper image but requires more disk space for file saving.  
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2.1.1.2. Sketched field map Preparation 

The parcel borders demarcated with pencil should be demarcated with pen so as to be more 

visible for Digitizing using QGIS.  Make circles around the grid crosses as close to the four 

corners of the Sketched field map as possible. Then make three circles along horizontal 

line(X- grid) and three circles along vertical line(Y-grid) on the sketched field map. Write the 

numbers 0-8 close to the circles, beginning at upper left and following the structure on figure 

8. Circle 0, 1, 2 shall be on the same horizontal line, as well as 3, 4, 5 and 6, 7, 8. At the same 

time, circle 0, 3, 6 as well as 1, 4, 7 and 2, 5, 8 should be on the same vertical line. When you 

make a circle of grid cross don’t over write on the cross section point. 

 

 Figure 2. 2. Preparation of sketched field map 
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Prepare a table of the coordinates of the circled grid crosses since all coordinates may not be 

visible on the scanned image. 

Table 2. 1. Plotting Coordinate points on the sketched field map 

 

2.1.2. Scanning and preparing field registration forms 

Filed registration forms are called parcel registration forms. A Parcel registration forms are 

documents used to register a parcel of land with the appropriate authorities. These forms are 

typically used when a new parcel of land is created or when there is a change of ownership or 

other significant change to an existing parcel. It typically requires detailed information about 

the parcel of land, including its location, size, boundaries, and any structures or other features 

on the land. The form may also require information about the previous owner or owners of 

the land, as well as any liens or other encumbrances on the property. Here are some examples 

of parcel registration forms: 

I. Land Parcel Registration Form.      

II. Parcel Registration Application  

III. Parcel Registration Form for New Developments.  

These are just a few examples, but the specific requirements for parcel registration forms can 

vary depending on the jurisdiction and the purpose of the registration. 
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Table 1. Example of field registration form 

 

Before we can fill in information on the field data registration form, the field data registration 

form must be assigned a serial number. The serial number/code is a unique identifier for the 

form and helps to organize information in the future and to consider it with the book of 

registry. For those used in the kebele, it will be done by giving a three-digit 

identification/code starting from 001 so that there is no repetition of forms. These forms are 

fill the land parcel information and holder’s information after surveying works or call it 

demarcation in front of the land holders.   

Scanning and preparing field registration forms can be a time-consuming process, but it is an 

important step in ensuring that the data collected in the field can be easily managed and 

analyzed. By following best practices for scanning, digitizing, organizing, verifying, and 

managing the data, organizations can ensure that they are able to make the most of the data 

they collect and use it to inform decision-making and improve outcomes. 
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Scanning and preparing field registration forms involves digitizing paper forms and 

converting them into a digital format that can be easily stored and managed. The following 

are some steps that can be taken to scan and prepare field registration forms: 

1. Identify the forms: The first step in scanning and preparing field registration forms is 

to identify the forms that need to be scanned. This may include registration forms for 

events, surveys, or other types of data collection. 

2. Determine the scanning process: The next step is to determine the scanning process. 

This may involve using a desktop scanner to scan the forms, or using a mobile app to 

capture the forms using a smartphone or tablet. 

3. Prepare the forms: Before scanning the forms, it is important to prepare them by 

removing any staples or paper clips and ensuring that the forms are in good condition. 

This will help to ensure that the forms are scanned accurately and are legible once 

digitized. 

4. Scan the forms: Once the forms have been prepared, they can be scanned using a 

desktop scanner or mobile app. It is important to ensure that the scans are of high 

quality and that they capture all of the necessary information on the forms. 

5. Convert to digital format: After the forms have been scanned, they need to be 

converted into a digital format that can be easily stored and managed. This may 

involve converting the forms to a PDF or other digital format, or using optical 

character recognition (OCR) software to convert the forms into a searchable format. 

6. Organize the forms: Once the forms have been converted to a digital format, they 

should be organized in a way that makes them easy to manage and access. This may 

involve creating a folder structure that groups related forms together or using a 

database to organize the forms. 

7. Verify the data: After the forms have been scanned and digitized, it is important to 

verify that the data has been accurately captured. This may involve manually 
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reviewing the forms to ensure that all of the necessary information has been captured, 

or using automated tools to check for errors or inconsistencies. 

8. Establish data management practices: Once the forms have been digitized, it is 

important to establish data management practices to ensure that the data remains 

accurate and up-to-date. This may involve creating backup copies of the data, 

establishing a process for updating the data as new information becomes available or 

establishing access controls to ensure that the data is only accessible to authorized 

users. 

 

Figure 2. 3. FRF 
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2.2. Managing point data in different format and upload  

Managing point data in different formats and uploading it to a GIS system can be a 

challenging task, but there are several steps that can be taken to make the process easier and 

more efficient. The following are some steps that can be taken to manage point data in 

different formats and upload it to a GIS system: 

1. Identify the data formats: The first step in managing point data is to identify the 

different data formats that need to be managed. This may include shapefiles, CSV 

files, Excel spreadsheets, or other proprietary formats. 

2. Convert the data: Once the data formats have been identified, the next step is to 

convert the data into a format that can be easily managed and uploaded to the GIS 

system. This may involve using software to convert the data into a common format 

such as CSV or shapefile. 

3. Organize the data: Once the data has been converted, it should be organized in a way 

that makes it easy to manage and upload to the GIS system. This may involve creating 

a folder structure that groups related data together or using a database to organize the 

data. 

4. Clean the data: Before uploading the data to the GIS system, it is important to clean 

the data to ensure that it is accurate and free of errors. This may involve removing 

duplicate records, correcting spelling errors, or removing any unnecessary data. 

5. Upload the data: Once the data has been cleaned and organized, it can be uploaded to 

the GIS system. This may involve using software to upload thedata to a database or 

using a web interface to upload the data directly to the GIS system. 

6. Verify the data: After uploading the data, it is important to verify that it has been 

successfully uploaded and is accessible in the GIS system. This may involve checking 

that the data is properly formatted and that it can be viewed and analyzed in the GIS 

system. 

7. Establish data management practices: Once the data has been uploaded to the GIS 

system, it is important to establish data management practices to ensure that the data 

remains accurate and up-to-date. This may involve establishing a process for updating 
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the data as new information becomes available or creating backup copies of the data 

to ensure that it is not lost if the system fails. 

Overall, managing point data in different formats and uploading it to a GIS system requires 

careful planning and attention to detail. By following best practices for data conversion, 

organization, cleaning, uploading, and verification, organizations can ensure that their point 

data is accurate, accessible, and useful for a variety of purposes.. 

 
 

Figure 2. 4. A. Window mobile device center: To process RTKm GPS data (left) B.  

Excel to specify text data in a tabular from (right). 

2.3. Uploading the required data on QGIS   

2.3.1. File structure  

File structure is needed to make our data 

 well-organized, 

 Simple,  
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 secure , 

 Sustainable and  

2.3.1.1. Start File structure preparation     

 Click the Start button on the Windows
®
 taskbar.  

 Point to My computer.  

 Point to Local Disk(D) or (E) 

 Create file structure like below(Example of Bambasi Woreda, Mender46 Trail Keble) 
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2.3.2. Installation of QGIS software and plugins 

2.3.2.1. Introduction to QGIS 

QGIS (formerly Quantum GIS) is an open-source geographic information system (GIS). This 

software is a free alternative to proprietary GIS software such as ESRI’s ArcGIS products 

which can be very expensive. QGIS incorporates similar functions and features as its 

proprietary counterparts and allows users to display, manipulate and create spatial data. It 

supports a variety of spatial data file extensions (.shp, .tif, .csv, .img, etc.) and is compatible 

on Linux, Unix, Mac, and Windows operating systems. 

Quantum GIS (QGIS) supports most geospatial vector and raster file types and database 

formats and offers standard GIS functionality, with a variety of mapping features and data 

editing. QGIS also has support for plugins that expands its functionality further by providing 

additional tools namely: GPS data support, geo referencing, and additional mapping 

components. 

2.3.2.2. Installation of QGIS Software and Plugins 

 Installation of QGIS Software 

Installation of QGIS is very simple. It does not require licensed number like ArcGIS 

Packages. Get the latest information on binary packages at the QGIS website at 

http://download.qgis.org.  

 You can simply right click and open QGIS software set up which is compatible with 

your computer operating system. 

For Example; if your computer is 32-bit operating system you can use QGIS-OSGeo4W-

3.16.7-1-Setup-x86.exe. After selecting compatible software installation module with your 

computer operating system, you can continue the installation process following the 

installation wizards. 

 Double click on the file QGIS-osgeo4w-3.16.7-1-Setup.exe. You will get a popup 

window with a security warning. 

 Hit the run button (Ok) to start the installation process and follow the prompts.  

http://download.qgis.org/
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 Follow the installation instructions.  Click Next, > I Agree, > Next, > Install.     

 QGIS will begin to install.  It may take a few minutes to complete.  
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 Installation of QGIS plugins  

A plugin is an additional software module that can be downloaded or created with 

development tools like the Qt Designer that is included in the QGIS installation. The plugins 

can be downloaded through the Plugins Manager (Plugins, Manage and install Plugins in the 

main menu). Each plugin depending on the user requirement can be downloaded from 

https://plugins.qgis.org/plugins/ and Plugin’s manager can assist in installing them 

downloaded zip file. 

Managing Plugins 

 To open the Plugin Manager, click on the menu item Plugins ► Manage and Install Plugins. 

 

 Plugin Manager can be used to deactivate and reactivate the plugin by clicking in the 

checkbox next to it. 

 

Installing New Plugins (online from repository)  

The list of plugins that you can activate and deactivate draws from the plugins that you 

currently have installed. To install new plugins: 

 Select the Not Installed option in the Plugin Manager dialog. The plugins available for 

you to install will be listed here. This list will vary depending on your existing system 

https://plugins.qgis.org/plugins/
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setup. 

 Find information about the plugin by selecting it in the list 

 Install the one(s) you are interested in by clicking the Install Plugin button below the 

plugin information panel. 

Note that if the plugin has some error, it will be listed in the Invalid tab. You can then contact 

the Plugin owner to fix the problem. 

 . 

Installing Plugins from Zip file 

If online access is not possible, plugins can be installed in QGIS using Install from ZIP. 

 Select the Install from ZIP option in the Plugin Manager dialog.  

 ZIP file downloaded from online Plugin repository can be browsed and installed using 

Browse Icon.  

Note that ZIP file directory in your computer must be identified and located here in 

the browse box. 
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 Install the one(s) you are selected directory in by clicking the Install Plugin button 

below the ZIP file directory panel. 
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2.3.3.   Explore QGIS Graphical User Interface (GUI) 

The QGIS GUI (Graphical User Interface) is divided into five areas: 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Menu Bar 

2. Tool Bar  

3. Browser Planal     

4. Map Legend / Layer List /  

5. Map View / Map Canvas 

6. Status Bar 

 Main Menu Bar 

This bar found on the top section below the title bar, which you can locate a number of 

menus such as Project, Edit, View, Layer, Settings, Plugins etc used to managed and 

communicate with different tools and QGIS functions. Most of case these menus can be used 

to customize and integrate various working packages and modules.  

 

5 

3 

3 

2 

1 

6 

4 

3 
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 The Browser Panel 

The QGIS Browser is a panel in QGIS that lets you easily navigate in your database. You can 

have access to common vector files (e.g., ESRI Shapefile or MapInfo files), databases (e.g., 

PostGIS, Oracle, SpatiaLite, GeoPackage or MSSQL Spatial) and WMS/WFS connections. 

You can also view your GRASS data. 

 Toolbars 

Your most often used sets of tools can be turned into toolbars for basic access. For example, 

the File toolbar allows you to save, load, print, and start a new project. You can easily 

customize the interface to see only the tools you use most often, adding or removing toolbars 

as necessary via Settings ‣ Toolbar’s menu. 

 Map View / Map Canvas 

This is where the map itself is displayed and where layers are loaded. In the Map View you 

can interact with the visible layers: zoom in/out, move the map, select features and many 

other operations. 

 The Status Bar 

It shows you information about the current map. Also allows you to adjust the map scale, the 

map rotation and see the mouse cursor’s coordinates on the map.  

 

2.3.4. General Setting in QGIS 

2.3.4.1. QGIS Project Properties  

The state of your QGIS session is called a project. QGIS works on one project at a time. Any 

settings can be project-specific or an application-wide default for new projects.  

 QGIS can save the state of your workspace into a project file using the menu options  

 Project ‣ Save or  

 Project ‣ Save As 
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At startup, a list of recently opened projects is displayed, including screenshots, names and 

file paths (for up to ten projects). This is a handy quick way to access recently used projects. 

Double-click an entry in this list to open the corresponding project. If you instead want to 

create a new project, just add any layer and the list disappears, giving way to the map canvas. 

 Create New Project  

 If you want to clear your session and start fresh, go to Project ‣ New. This will 

prompt you to save the existing project if changes have been made since it was 

opened or last saved. 

 

 Project Coordinate Reference System  

Every project in QGIS also has an associated Coordinate Reference System. The project CRS 

determines how data is projected from its underlying raw coordinates to the flat map rendered 

within your QGIS map canvas. 

QGIS supports “on the fly” CRS transformation for both raster and vector data. This means 

that regardless of the underlying CRS of particular map layers in your project, they will 

always be automatically transformed into the common CRS defined for your project. Behind 

the scenes, QGIS transparently reprojects all layers contained within your project into the 

project’s CRS, so that they will all be rendered in the correct position with respect to each 

other. 

 Select Settings in the main menu, followed by Project properties. 

 Select Adindan / UTM zone 37N in the Coordinate reference systems of the world list.  
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 “37” represents the zone, which is 37 on national level, but 36-38 regionally.  To find it 

quicker in the very long list of coordinate systems, click in the Filter field, and write 

Adindan to filter out the needed options in the list.  

 Select Adindan / UTM Zone 37N zone (depending on your geographic location relative 

to 36, 37 and 38 zone) and click on OK. From now on, you can find Adindan / UTM 

zone 37N in the quick selection list at the top of the coordinate system selection window.  

 Remember to NEVER select any WGS-84 system, since it will give an error of more 

than 220m compared to the Adindan system. The only exception is if the background 

image is given in that system. 

 Note that the other projection zones are found in the far Eastern (zone 38) and Western 

(zone 36) parts of Ethiopia. In case of uncertainty about the projection zone at a certain 

location, it can be found by activating a handheld GPS at the location. If UTM Adindan 

is selected as the map projection in the GPS, it will automatically display the correct 

zone. 
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 Working with Project General Setting  

 

In the General menu, the project title, selection and background color, layer units, precision, 

and the option to save relative paths to layers can be defined. If the CRS transformation is on, 

you can choose an ellipsoid for distance calculations. You can define the canvas units (only 

used when CRS transformation is disabled) and the precision of decimal places to use. You 

can also define a project scale list, which overrides the global predefined scales. 

 

 Set Ellipsoid to none/Planimetric to get correct area calculations. If Clarke 1880 is 

selected instead, the areas will be wrong!  

 Note that the ellipsoid selection must be done after the selection of coordinate system, 

since that selection automatically switches the ellipsoid back to Clarke 1880! 

 

Figure 2. 5. Settings of Measure tool for the project. 
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2.3.4.2. Setting Options  

Some basic options for QGIS can be selected using the Options dialog.  

 Select the menu option Settings ‣  Options. The tabs where you can customize your options 

are described below. 

 

  Choose Settings, Options in the main menu.  

 Click on CRS in the list to the left. Mark the options Enable on the fly reprojection by 

default, and use the default CRS. Select Project CRS (which should be Adindan / 

UTM Zone 37N) in the two lists. 

 

https://docs.qgis.org/2.8/en/_images/mActionOptions.png


                                             

 

Page 42 of 

129 

 

Ministry of Labor and 

Skills 

Author/Copyright 

Rural Land Administration 

Level II 

Version I 

January 2023 

 

 

2.3.4.3. Settings for Map Tool /Map Scale  

This tab offers some options regarding the behavior of the Identify tool, Measure tools, 

zooming and Predefined Scale. 

 Predefined scales 

Here, you find a list of predefined scales. With the  and  buttons you can add or remove 

your personal scales. You can also import or export scales from/to a .XML  file. Note that 

you still have the possibility to remove your changes and reset to the predefined list. 

 Choose Settings, Options in the main menu.  

 Click on the Map tools line in the list to the left in the window. 

 Check the settings in the windows below. Click on the  button and add the scales 

1:500, 1:1500, 1:2000, 1:3000 and 1:4000. 

 

 An example of how the scale 1:3000 is entered in the box.  

 

https://docs.qgis.org/3.16/en/_images/symbologyAdd.png
https://docs.qgis.org/3.16/en/_images/symbologyRemove.png
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2.3.4.4.  Selecting and adjusting the panels and toolbars 

By default, QGIS provides many panels to work with. Some of these panels are described 

below while others may be found in different parts of the document. A complete list of 

default panels provided by QGIS is available via the View ► Panels ► menu and mentioned 

at Panels.  

When a new project is started in QGIS, we sometimes have a lot of unnecessary Panels that 

disturb us, are too big/small, are in the wrong place or there are no panels at all. The tool 

boxes (with all icons) might also need some adjustment. 

 

 Begin with selecting View and Panels in the main menu. Then click in the boxes so 

that only the Layers panel is active. 

 

Figure 2. 6.  Panel selection list 
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The Browser Panel 

The Browser is one of the main ways to quickly and easily add your data to projects. It’s 

available as: 

 a Data Source Manager tab, enabled pressing the Open Data Source Manager button 

(Ctrl+L); 

 as a QGIS panel you can open from the menu View ► Panels (or   Settings ► Panels) or 

by pressing Ctrl+2. 

In both cases, the Browser helps you navigate in your file system and manage geodata, 

regardless the type of layer (raster, vector, table), or the data source format (plain or 

compressed files, databases, web services). 

 

 Now go to the dotted line  to the right of the title Layers panel. 

 

Figure 2. 7. Layers panel title. 

 Click and hold down the mouse button. Move the panel to the left until a gray empty 

field appears behind the moved panel. Release the mouse button to place the panel in 

the empty field. 
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Figure 2. 8. Gray box appearing when moving the panel to the left 

 To adjust the width of the panel, click on its right border and hold down the mouse. 

The mouse cursor will then change shape as shown below. Move the mouse to the left 

or right to change the width. Release when it looks OK. 

 

Figure 2. 9. The mouse cursor when changing the panel width 

 To get the needed icon toolbars displayed, choose View and Toolbar in the main 

menu. By repeatedly selecting this and marking/unmarking the boxes, prepare the 

selection in the figure below. To deselect Digitizing tools (second from the bottom) is 

not a mistake in the document! This toolbar contains only advanced functions (e.g. 

combining features in different layers) that are not of use for our purpose. 
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Figure 2. 10. The Toolbar list (left), example of a toolbar (right) 

 Try to arrange the toolbars so that they fill each row and thereby take minimum space 

from the map. 

The toolbars are moved by clicking and holding down the mouse on the dotted 

column  to the left of each toolbar. 

 The Map Navigation toolbar  should be moved to 

the right of the screen, so it becomes vertical. The reason is that the icons of this 

toolbar are often used many times during the digitizing, so it is good to have them as 

close as possible to the map. It is also less tiring for the hand to move the mouse 

sideways than up or down (try for yourself)!  

 The QGIS interface could then look something similar to the figure below. 
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Figure 2. 11. Suggested layout of toolbars and panels 
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2.3.5. Working with Raster and Vector Data  

2.3.5.1. Working with Raster Data  

Raster data is quite different from vector data. Vector data has discrete features with 

geometries constructed out of vertices, and perhaps connected with lines and/or areas. Raster 

data, however, is like any image. Although it may portray various properties of objects in the 

real world, these objects don’t exist as separate objects. Rather, they are represented using 

pixels with different values. 

 Adding Raster Data 

If you have a georeferenced image or aerial imagery, you will need to import them using the 

Add Raster Layer button. To import a raster file, follow these steps: 

 Click on the "Layer" menu, mouse-over "Add Layer" and click on "Add Raster 

Layer..." or click on the "Add Raster Layer icon in the left column of QGIS. 

 

 You will automatically be directed to your folders.  Go to the folder where your raster 

are stored and change the raster data type if needed by click on the drop-down menu 
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next to the file name. 

 

 

 Click Add. 

 Now you will see both the raster’s loaded in QGIS. The raster is rendered as in 

grayscale, where darker pixels indicate lower values and lighter pixels indicate higher 

values. 

 

 Identify tool 

The identify Icon is located in attribute Toolbar  
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 Once the layer is loaded, select the Identify tool and click anywhere on the layer. You 

will see the Reflectance value of the image in RGB band at that selected location. 

 

 

 Changing Raster Symbology  

Basic Raster Metadata (Information and Source Tab) 

The metadata Information tab is read-only and represents an interesting place to quickly 

grab summarized information and metadata for the current layer. Provided information are: 

 Based on the provider of the layer (format of storage, path, data type, extent, 

width/height, compression, pixel size, statistics on bands, number of columns, rows and 

no-data values of the raster); 

 Picked from the provided metadata: access, links, contacts, history… as well as dataset 

information (CRS, Extent, bands…).  

The system Source tab displays basic information about the selected raster, including:  

 the Layer name to display in the Layers Panel; 

 the Coordinate Reference System: Displays the layer’s Coordinate Reference System 

(CRS).  

You can change the layer’s CRS, by selecting a recently used one in the drop-down list or 

clicking on the set. Projection Select CRS button. Use this process only if the layer CRS is a 
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wrong or not specified. If you wish to reproject your data, use a reprojection algorithm from 

Processing or Save it as new dataset. 

 

Band Rendering  

QGIS offers many different Render types. The choice of renderer depends on the data type 

and the information you’d like to highlight. 

 Multiband color; if the file comes with several bands (e.g., a satellite image with 

several bands). With the multiband color renderer, three selected bands from the 

image will be rendered, each band representing the red, green or blue component that 

will be used to create a color image. 
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 Paletted/Unique values; for single band files that come with an indexed palette (e.g., 

a digital topographic map) or for general use of palettes for rendering raster layers. 

 Single band gray; (one band of) the image will be rendered as gray. QGIS will 

choose this renderer if the file is neither multiband nor paletted (e.g., a shaded relief 

map). 

 Single band pseudocolor; this renderer can be used for files with a continuous 

palette or color map (e.g., an elevation map). 

 Hillshade; Creates hillshade from a band. 

 Contours; Generates contours on the fly for a source raster band. 

Color Rendering  

Raster data from arial photo and satellite image contains inadequate contrast and brightness. 

This particularly emphasized that when the images are imported, they will normally appear a 

bit dark and colorless, especially if they are printed on paper. It is sometimes difficult to 

identify the parcel border lines drawn by pen if the image background is dark. To enhance 

brightness, colour and contrast, we should therefore make some changes in the display 

settings for each image settings.  

To adjust the Contrast, Brightness and Saturation, follow the following steps.  
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 Open the Layer Properties dialog for the Raster layer by right-clicking (double clicking) 

on the layer in the Layer tree and selecting Properties option. 

 Switch to the Symbology tab. 

The properties window for the image will then open. Now choose symbology in the list 

to the left.  

 On color rendering sub-window; As a guideline, change the values for Brightness to 40 

or 50, the Contrast to 40 and the Saturation to 20 (pointed out by blue arrows). For 

images that are generally darker or brighter than the average image, some 

experimenting with the values might create even better results.  

 Finally click on OK to apply the changes. 
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Right mouse button menu for raster layers 

 Zoom to Layer Extent 

 Stretch Using Current Extend 

 Show in Overview 

 Remove 

 Duplicate 

 Set Layer CRS 

 Set Project CRS from Layer 

 Save as ... 

 Properties etc……

Before  After 
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2.3.5.2.  Working with Vector Data 

Vector data is arguably the most common kind of data you will find in the daily use of GIS. The 

vector model represents the location and shape of geographic features using points, lines and 

polygons (and for 3D data also surfaces and volumes), while their other properties are included 

as attributes (often presented as a table in QGIS). It is usually used to store discrete features, like 

roads and city blocks. The objects in a vector dataset are called features, and contain data that 

describe their location and properties. 

 Adding Vector Data  

You can add vector data such as point, line and polygon file using two methods  

 Layer > Add Layer or  

 Add Vector Data Toolbar in Manager Layer Toolbar  

 

 Click Add Vector Layer tool in your "Manage Layers" toolset 

 Click Browse button and locate the "Kebele_Admin.shp" shapefile in the QGIS 

Data/Shapefiles folder in Training QGIS folder. 
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 If the shapefiles you have are on your local machine, all you need to do is click on the 

Browse button and navigate to the folder where your shapefiles are.    

 After Navigate to the data working director, you find the folder with your shapefiles; you will 

need to be sure the data type is selected to shapefile.  Click on the drop-down box next to file 

name and select ESRI Shapefiles (.shp *SHP).   

 

 Click Add. 

 

Working with Layer Symbology  

The symbology of a layer is its visual appearance on the map. The basic strength of GIS over 

other ways of representing data with spatial aspects is that with GIS, you have a dynamic visual 

representation of the data you’re working with. 

Therefore, the visual appearance of the map (which depends on the symbology of the individual 

layers) is very important. The end user of the maps you produce will need to be able to easily see 

what the map represents. Equally as important, you need to be able to explore the data as you’re 

working with it, and good symbology helps a lot. 

In other words, having proper symbology is not a luxury or just nice to have. In fact, it’s 

essential for you to use a GIS properly and produce maps and information that people will be 

able to use. 

i) Changing Layer Colors 
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To change a layer’s symbology, open its Layer Properties. Let’s begin by changing the color of 

the Woerda_Kebele layer. 

 Right-Click on the Woreda_Kebele layer in the layers list. 

 Select the menu item Properties… in the menu that appears. 

Note that by default, you can also access a layer’s properties by double-clicking on the 

layer in the Layers list. 

 In the Layer Properties window, select the  Symbology tab: 

 Click the color select button next to the Color label. A standard color dialog will appear. 

 Choose a gray color and Gray 1 fill click OK. 

 Click OK again in the Layer Properties window, and you will see the color change being 

applied to the layer. 

 

ii) Changing Symbol Structure 

This is good stuff so far, but there’s more to a layer’s symbology than just its color. Next we 

want to eliminate the lines between the different land use areas so as to make the map less 

visually cluttered. 

 Open the Layer Properties window for the Woreda_Kebele layer. 

https://docs.qgis.org/3.16/en/_images/symbology.png
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 Under the Symbology tab, you will see the same kind of dialog as before. This time, 

however, you’re doing more than just quickly changing the color. 

 In the symbol layers tree, expand the Fill dropdown and select the Simple fill option. 

 Click on the Stroke style dropdown. At the moment, it should be showing a short line and 

the words Solid Line. 

 Change this to Dash Line. 

 

 

 Click OK. 

iii) Categorize 

Once you join tabular data to shapefiles in QGIS or have a shapefile with numeric or categorical 

data, you can symbolize the data using the Style tab in the layer properties: 

 Double-click or right-click the shapefile/layer you want to symbolize and select 

Properties. 

 Click on the Symbology tab. 

 Choose between Categorical or Graduated (numerical) symbology depending on the type 

of data you have.   
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If you have data that is broken into categories (i.e., male or female, hair color, political 

party, etc.) you will choose the Categorized option.   

 Next to the column option, use the drop-down arrow and select Categorized.  Find the 

field with categorized data (in this case, election data) and select it. 

 Click Classify and the different categories will populate the Value field. 

 Click OK. 

 

iv) Numerical Data 

If you have numeric data you want to symbolize (i.e., Area) choose "Graduated" symbology. 

 Next to the Column option, use the drop-down arrow to select Graduated, and select a field 

with numerical data. For this exercise “Area”    

 Choose a classification mode Equal Interval, define the number of Classes (as 4 Classes), 

and click on Classify. 
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 You can change the color scheme by clicking on the drop-down arrow next to the Color 

ramp. 

 Click OK. 

 

The result will look like this: 
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2.3.6.  Geo-Referencing Scanned Field Maps/Sketched Maps 

Geo-referencing is about using map coordinates to assign a spatial location to map features. All 

the elements in a map layer have a specific geographic location and extent that enables them to 

be located on or near the earth's surface. Describing the correct location and shape of features 

requires a coordinate framework for defining real-world locations. A geographic coordinate 

system is used to assign geographic locations to objects. A global coordinate system of latitude-

longitude is one such framework.  

Another is a planar or Cartesian coordinate system derived from the global framework. Maps 

represent locations on the earth's surface using grids, graticules, and tic marks labeled with 

various ground locations; both in measures of latitude-longitude and in projected coordinate 

systems, such as UTM meters. The geographic elements contained in various map layers are 

drawn in a specific order (one on top of another) for the given map extent. GIS datasets contain 

coordinate locations within a global or Cartesian coordinate system to record geographic 

locations and shapes.  

2.3.6.1. Georeferencing Function 

Most GIS projects require georeferencing some raster data. Georeferencing is the process of 

assigning real-world coordinates to each pixel of the raster. Many times, these coordinates are 

obtained by doing field surveys - collecting coordinates with a GPS device for few easily 

identifiable features in the image or map. In some cases, where you are looking to digitize 

scanned maps, you can obtain the coordinates from the markings on the map image itself. Using 

these sample coordinates or GCPs (Ground Control Points), the image is warped and made to fit 

within the chosen coordinate system.  

Pre-requisites: 

 A scanned image in TIFF format. 

 Circles with numbers 0-8 around selected grid crosses in the image. 

 A coordinate list of selected grid crosses created. 

 A QGIS project opened, with the Adindan / UTM zone 36N/37N/38N coordinate system 

selected. 
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Note that: The Coordinate Reference System massage wizard is displayed simultaneously when 

you open geo-referencers. This massage helps us to define the layer coordinate reference system. 

Ethiopia is falling in three zones and we have to make sure in which zone our data layer is 

falling. So, before you are starting to georeferencing back to your project and you should have to 

define your coordinate reference system which is fitted to the known location. For this exercise 

we are going to set the Zone to UTM zone 36 because Assosa woreda is found under the zone 

36. 

Table 2: List of icon and their respective purpose 

Icon Purpose Icon Purpose 

 

Open raster 
 

Start georeferencing 

 

Generate GDAL Script 
 

Load GCP Points 

 

Save GCP Points As 
 

Transformation settings 

 

Add Point 
 

Delete Point 

 

Move GCP Point 
 

Pan 

 

Zoom In 
 

Zoom Out 

 

Zoom To Layer 
 

Zoom Last 

 

Zoom Next 
 

Link Georeferencer to QGIS 

 

Link QGIS to Georeferencer 
 

Full histogram stretches 

 

Local histogram stretches   

Usual procedure 

As X and Y coordinates (DMS (dd mm ss.ss), DD (dd.dd) or projected coordinates 

(mmmm.mm)), which correspond with the selected point on the image, two alternative 

procedures can be used: 

 The raster itself sometimes provides crosses with coordinates “written” on the image. In 

this case, you can enter the coordinates manually. 

https://docs.qgis.org/3.4/en/_images/mActionAddRasterLayer.png
https://docs.qgis.org/3.4/en/_images/mActionStart.png
https://docs.qgis.org/3.4/en/_images/mActionGDALScript.png
https://docs.qgis.org/3.4/en/_images/mActionLoadGCPpoints.png
https://docs.qgis.org/3.4/en/_images/mActionSaveGCPpointsAs.png
https://docs.qgis.org/3.4/en/_images/mActionTransformSettings.png
https://docs.qgis.org/3.4/en/_images/mActionAddGCPPoint.png
https://docs.qgis.org/3.4/en/_images/mActionDeleteGCPPoint.png
https://docs.qgis.org/3.4/en/_images/mActionMoveGCPPoint.png
https://docs.qgis.org/3.4/en/_images/mActionPan.png
https://docs.qgis.org/3.4/en/_images/mActionZoomIn.png
https://docs.qgis.org/3.4/en/_images/mActionZoomOut.png
https://docs.qgis.org/3.4/en/_images/mActionZoomToLayer.png
https://docs.qgis.org/3.4/en/_images/mActionZoomLast.png
https://docs.qgis.org/3.4/en/_images/mActionZoomNext.png
https://docs.qgis.org/3.4/en/_images/mActionLinkGeorefToQGis.png
https://docs.qgis.org/3.4/en/_images/mActionLinkQGisToGeoref.png
https://docs.qgis.org/3.4/en/_images/mActionFullHistogramStretch.png
https://docs.qgis.org/3.4/en/_images/mActionLocalHistogramStretch.png
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 Using already georeferenced layers. This can be either vector or raster data that contain 

the same objects/features that you have on the image that you want to georeference and 

with the projection that you want for your image. In this case, you can enter the 

coordinates by clicking on the reference dataset loaded in the QGIS map canvas. 

The usual procedure for georeferencing an image involves selecting multiple points on the raster, 

specifying their coordinates, and choosing a relevant transformation type. Based on the input 

parameters and data, the plugin will compute the world file parameters. The more coordinates 

you provide, the better the result will be. 

a) Open QGIS  

b) Choose Raster, Georeferencer and Georeferencer in the menu. 

 

The Georeferencer a tool for generating world files for raster. It allows you to reference raster to 

geographic or projected coordinate systems by creating a new GeoTiff or by adding a world file 

to the existing image. The basic approach to georeferencing a raster is to locate points on the 

raster for which you can accurately determine coordinates. 
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The plugin window is divided into 2 sections. The top section where the image will be displayed 

and the bottom section where a table showing your GCPs will appear. 

c) Now, Click the Open Raster button at the top left corner of the Georeferencer window and 

browse to the file system location of the map image file you would like to georeference, then  

d) Click Open.  

 

 

 

Use the  button to zoom several times to the grid cross with the circle numbered as zero. It 

is important to zoom in very close to the grid cross to be able to mark it exactly. Now select the 

button  and you will then be asked to give the GCP coordinates.  

 Enter the coordinates exactly like the following table to georeferencing the image. The 

coordinates should be entered with Easting before Northing. After clicking OK, the 

coordinates should appear in the GCP table. 
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No Coordinates 

Easting Northing 

0 676700 1104800 

1 677000 1104800 

2 677300 1104800 

3 676700 1104600 

4 677000 1104600 

5 677300 1104600 

6 676700 1104400 

7 677000 1104400 

8 677300 1104400 

 Zoom out to see the whole image by clicking on. Then zoom in to the grid cross with 

circle number one and mark exactly in the middle of the cross. Give the GCP coordinates 

as described before, and continue for all circled grid crosses. Be very careful to enter the 

right coordinates and to select the right grid cross.  

 When all nine (0-8) selected grid crosses are measured, carefully check the GCP table. 

The point groups 0, 1, 2 and 3, 4, 5 as well as 6, 7, 8 should have the same dstY 

(Northing) coordinates, and for dstX (Easting) the groups 0, 3, 6 and 1, 4, 7 as well as 2, 5, 

8 shall have the same coordinates. If there is an error, double-click in the box to change it. 

Look at the image to see that the numbers 0-8 found on the same places as the circles on 

the paper map. 
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 When all checks are performed, click on  Settings and Transformation settings.  Set 

Transformation type to Polynomial 2, Resampling method to Linear and Compression to 

NONE. 

 Click on the Output raster  button and Save to your file folder georeferenced field 

maps without changing anything. This will mean that you will create a corrected output 

file which has the same name as the input file but with “modified” added to the name. 

This file is rotated so that north is exactly straight up on the image, and also has reference 

information built into it. 

 Then click on the Coordinate System button . Choose Adindan / UTM zone 36N in the 

quick list and click on OK. 

 Finally check that the box Load in QGIS when done is marked, and click on OK. 
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Figure 2. 12. The transformation setting window 

 Now click twice on the column Residuals (pixels) in the GCP table. It should now be 

sorted with the highest residual first. If the highest value is less than one, the Geo-

referencing will be performed without trouble. If the highest error is higher than one, 

zoom in any of place on image and then double click on to the point with the largest 

error. Points that are totally wrong in GCP coordinates or marked very wrong on the 

screen can be deleted by selecting  delete point. 

And clicking on the erroneous point to delete it both on the screen and in the table.  
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 If the point is close but clearly needs to be moved, push the  button, 

click on the wrong point and hold down the mouse button. Then move the point to the 

right place and release the button. Check the residuals again to see that the largest residual 

is now below one. If not, double-click on the largest row to automatically zoom in to that 

and correct it. Also check that the dstX and dstY (Easting and Northing) coordinates are 

correct on the paper image gridlines. 

 
Example of a displaced point 

 When the residuals are OK, push the   start georeferencing button to start the process. 

A progress indicator will show when the new modified image is created. Finish by closing 

the Geo-reference window. Answer yes on the question to save the GCP points. 

 When coming back to the main Quantum window, check that the scale bar the coordinates 

under the image look realistic. Chose file, save project and we are now ready for 

digitizing. 
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2.3.6.2. Checking of geo-referencing accuracy  

Even if, you have checked and minimized the geo-reference residual error from GCP table, we 

cannot say it accurately done. Since the images have a printed grid, it is an easy and accurate 

procedure to check that grid by comparing it to a vector grid created in Quantum. To create such 

a grid (which can be used for several images), we proceed as follows: 

 In the main menu, choose Vector,  and .The 

following window will appear: 

 

 Set the Grid Extent by Click on Grid extent and choose Use Map Canvas Extent to 

determine grid extent. Minimum and maximum values for X and Y will then appear in 

the Grid extent frame. Round off the numbers to hundreds (the two last numbers in each 

editing field should be zeros). 
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Figure 2. 13. Minimum and maximum values before and after) rounding 

 To create the Vector grid file it needs Grid type, as Polygon, Grid extent set by The Map 

Extent Canvas, and Most importantly its need the Grid Horizontal and Vector Spacing for 

this example its seated as 2000 for both X and Y. 

 This will create a Square Vertical Grid. 

 The grid also must be saved using Grid Output radio button.  
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 The grid which is save and later displayed on layer and it is shown on the image. 

 

 Then click zoom in button to see the congruency of grid with image grid  
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 If vector grid is out of image grid the geo-reference should be repeated until to get 

equivalence.   

  

2.3.7.  Creating Parcel Geometry and Feature Extraction  

After the Geo-Referencing is over that means after assigning the spatial definition to your raster 

map, it is ready to be converted into the layers (Point, Line, and Polygon) that you can further 

handle for making query, solving problems and making decisions. This procedure is called data 

creation and consists of digitization and giving attributes to your data.   

2.3.7.1. Creating a New Vector Dataset 

The data that you use has to come from somewhere. For most common applications, the data 

exists already; but the more particular and specialized the project, the less likely it is that the data 

will already be available. In such cases, you’ll need to create your own new data. 

Before you can add new vector data, you need a vector dataset to add it to. In our case, you’ll 

begin by creating new data entirely, rather than editing an existing dataset. Therefore, you’ll 

need to define your own new dataset first. 

 Open QGIS and create a new blank project. 

 Navigate to and click on the menu entry Layer ► Create Layer ► New Shapefile Layer.  

You’ll be presented with the New Shapefile Layer dialog, which will allow you to define a new 

layer. 
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 Select the type of layer you want to create (point, , line and polygon)  

 Select the file format (UTF-8) 

 Select the specified CRS which is best fit in the specified area (Adindan/UTM zone 36N 

or 37N or 38N). For this project select zone 36N. 

 

 Select the Geometry Type as Polygon but can be (Point, Line and Polygon)  

 

 Select the File Encoding (UTF-8) 

 Select the specified CRS which is best fit in the specified area (Adindan/UTM zone 36N 

or 37N or 38N). For this project select zone 36N. 

 Define The Attribute New Field  

 In front of name write the attribute like (Region, Zone, woreda, kebele name, UPID, 

holder name, means of a question, acquisition date….). 

 Select the attribute type (text, whole number, decimal number) 

 Determine the width of the attribute character and precision when necessary. 

 Click add to attribute list and it is displayed on attribute list. 
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 Repeat the steps for all character you want to list on the attribute list. Use removes 

attribute button to avoid unwanted lists from the attribute list. 

  For example, id is listed in the attribute list by default. So, it can be avoid by 

highlighting over it and click remove attribute button. 

 After incorporating each attribute Fields Click “Ok”, you should create file name and 

expected to save on your project shape file. 

 

2.3.7.2.  Snapping 

Snapping makes topological editing easier. This will allow your mouse cursor to snap to other 

objects while you digitize. To be able to snap to the corners of neighboring parcels that has 

already been digitized napping option hat to be settled. 

To set snapping options: 

 Navigate to the menu entry Project ► Snapping Options…. 

 Set up your Snapping options dialog to activate the Parcel layer with Type vertex and 

tolerance 10 pixels: 

 

 Then select Advanced Configuration settings instead of All layer in the Snapping options list. 

 The window then changes to the following: 
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 Mark the box to the left of the Parcels layer to make the snapping active. The settings are 

then Mode: To vertex and segment, Tolerance: 10 and Units: Pixels. In addition, we mark the 

Avoid intersections box to the right. This will automatically avoid all overlaps by cutting 

away any overlapping part from a newly digitized parcel.  

 Do not activate the snapping for other layers than Parcels, since we normally have no reason 

to snap to other layers.  

 The Mode setting should be set to Vertex and segment (border point). This means in practice 

that the snapping can be done both on the border corners (vertex) and anywhere along a 

border line (segment). 

 If the setting To vertex and segment is selected and used, it is important that Avoid 

intersections is marked. If not, gaps and overlaps will occur if a corner is moved during 

parcel editing, which should be avoided! To show this with an example, a rectangular parcel 

is first digitized, with only four points (left in the figure below). When attaching a smaller 

parcel to the first one, we snap to the border segment at point B (middle). This is possible 

since To vertex and segment is selected. However, if Avoid intersections is not marked and 

we move the corner A, a gap or overlap is created at point B (right). 

 

Figure 2. 14. Topology errors created by the wrong snapping settings  

 Push OK to save the settings. 

 

2.3.7.3.  Digitize geo-referenced field maps and FRF data entry 

 

i) Add Data Sources 

When you create new data, it obviously has to be about objects that really exist on the ground. 

Therefore, you’ll need to get your information from somewhere. There are many different ways 
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to obtain data about objects. For example, you could use a GPS to capture points in the real 

world, then import the data into QGIS afterwards. Or you could survey points using a theodolite, 

and enter the coordinates manually to create new features. Or you could use the digitizing 

process to trace objects from remote sensing data, such as satellite imagery or aerial 

photography. For our example, you’ll be using the digitizing approach. Sample raster datasets are 

provided, so you’ll need to import them as necessary. 

 Click on Data Source Manager Button. 

 Select Add Raster Layer on the left side. 

 In the Source panel, click on the Browse button: 

 Navigate to the scanned map or orthophoto.  

 Select the file from the working directories in the training file  

 Click Add to close the dialogue window and Close. An image will load into your map 

If you don’t see an aerial image appear, select the new layer, right click, and choose Zoom to 

Layer in the context menu. 

 

 Click on the   Zoom In button, and zoom to the area highlighted in blue below: 

 Before starting to digitize, let’s move the Parcel layer above the aerial image. 

https://docs.qgis.org/3.16/en/_images/mActionZoomIn.png
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ii) Extraction Parcel Feature  

In order to begin digitizing, you’ll need to enter edit mode. GIS software commonly requires this 

to prevent you from accidentally editing or deleting important data. Edit mode is switched on or 

off individually for each layer. 

 To enter edit mode for the Parcel layer: 

 Click on the Parcel layer in the Layers panel to select it. 

 Click on the  Toggle Editing button. 

 If you can’t find this button, check that the Digitizing toolbar is enabled. There should 

be a check mark next to the View ► Toolbars ► Digitizing menu entry. 

 As soon as you are in edit mode, you’ll see that some digitizing tools have become 

active: 

 Other relevant buttons are still inactive, but will become active when we start 

interacting with our new data. 

 Notice that the layer Parcel in the Layers panel now has the pencil icon, indicating 

that it is in edit mode. 

 Click on the  Add Polygon Feature button to begin digitizing our school fields. 

 You’ll notice that your mouse cursor has become a crosshair. This allows you to more 

accurately place the points you’ll be digitizing. Remember that even when you’re 

using the digitizing tool, you can zoom in and out on your map by rolling the mouse 

wheel, and you can pan around by holding down the mouse wheel and dragging 

around in the map. 

 Click and drag the cursor on each corner of demarcated parcel until you close the 

polygon.  

 After placing your last point, right click to finish drawing the polygon. This will finalize 

the feature and show you the Attributes dialog. 

 Fill in the FRF data in front of each Attribute Fields.  
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Figure 2. 15. FRF data fill interface 

 Click OK, and you have created a new feature! 

 In the Layers panel select the Parcel layer. 

 Right click and choose Open Attribute Table in the context menu. 

In the table you will see the feature you just added which contains all the FRF data for the 

digitized parcel. While in edit mode you can update the attributes data by double click on 

the cell you want to update.  

 Close the attribute table. 

 To save the new feature we just created, click on save Edits Save Edits button. 

 

 

Remember, if you’ve made a mistake while digitizing a feature, you can always edit it 

after you’re done creating it. If you’ve made a mistake, continue digitizing until you’re 

done creating the feature as above. Then: 
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2.3.7.4. Encoding and Link the FRF Data  

This is performed in the office after the cadastral data is collected in the field. 

Field sheets will be scanned. Each file will be named after:  

 Field team number  

 Date (Ethiopian date: dd/mm/yyyy)  

 Form ID which is consecutive for each day  

The field data will be entered into computers by dedicated data entry staff in the local office by 

using Microsoft Excel. The sheet developed for this purpose is called Book of registry. 

 

2.3.8. Editing attribute table  

When a shapefile is created an attribute, table is also associated with the shapefile.  Also, any 

table (i.e., csv file) users bring into QGIS can be accessed using the Open Attribute table 

function. QGIS allows you to load spatial and non-spatial layers. This currently includes tables 

supported by OGR and delimited text, as well as the PostgreSQL, MSSQL, SpatiaLite, DB2 and 

Oracle provider. All loaded layers are listed in the Layers Panel. Whether a layer is spatially 

enabled or not determines whether you can interact with it on the map. 

Non-spatial tables can be browsed and edited using the attribute table view. Furthermore, they 

can be used for field lookups. For example, you can use columns of a non-spatial table to define 

attribute values, or a range of values that are allowed, to be added to a specific vector layer 

during digitizing. 

I. Opening Attribute Table  

 To access the attribute table, right-click the table or shapefile and select Open Attribute 

Table. 
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This will open a new window that displays the feature attributes for the layer 

 

The buttons at the top of the attribute table window provide the different functions.  

 

II. Editing Attribute Values 

Editing attribute values can be done by: 

 Typing the new value directly in the cell, whether the attribute table is in table or 

form view. Changes are hence done cell by cell, feature by feature; 

 Using the field calculator: update in a row a field that may already exist or to be 

created but for multiple features; it can be used to create virtual fields. 

 using the quick field calculation bar: same as above but for only existing field or 

using the multi edit mode: update in a row multiple fields for multiple features. 

https://docs.qgis.org/2.18/en/docs/user_manual/working_with_vector/attribute_table.html#id15
https://docs.qgis.org/2.18/en/docs/user_manual/working_with_vector/attribute_table.html#vector-field-calculator
https://docs.qgis.org/2.18/en/docs/user_manual/working_with_vector/attribute_table.html#quick-field-calculation-bar
https://docs.qgis.org/2.18/en/docs/user_manual/working_with_vector/attribute_table.html#multi-edit-fields
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III. Using the Field Calculator 

The  Field Calculator button in the attribute table allows you to perform calculations on the 

basis of existing attribute values or defined functions, for instance, to calculate length or area of 

geometry features. The results can be written to a new attribute field, a virtual field, or they can 

be used to update values in an existing field. 

The field calculator is available on any layer that supports edit. When you click on the Field 

Calculator icon the dialog opens. If the layer is not in edit mode, a warning is displayed and 

using the field calculator will cause the layer to be put in edit mode before the calculation is 

made. 

Based on the Expression Builder dialog, the field calculator dialog offers a complete interface to 

define an expression and apply it to an existing or a newly created field. To use the field 

calculator dialog, you first must select whether you want to only update selected features, create 

a new attribute field where the results of the calculation will be added or update an existing field. 

For Example: Calculating Area  

A short example illustrates how field calculator works when using the Expression tab. We want 

to calculate the area in ha of the Kebele.shp layer from the QGIS sample dataset: 

 Load the shapefile Kebele.shp  in QGIS and press  Open Attribute Table. 

 Click on  Toggle editing mode and open the  Field Calculator dialog. 

 Select the  Create A New Field checkbox to save the calculations into a new field. 

 Add Area as Output field name and Area as Output field type, and define Output field 

length to be 10 and Precision, 3. 

 Now double click on function $Area in the Geometry group to add it into the Field 

calculator expression box. 

 Complete the expression by typing /10000 in the Field calculator expression box and 

click [Ok]. 

https://docs.qgis.org/2.18/en/docs/user_manual/working_with_vector/attribute_table.html#id16
https://docs.qgis.org/2.18/en/_images/mActionCalculateField.png
https://docs.qgis.org/2.18/en/_images/mActionOpenTable.png
https://docs.qgis.org/2.18/en/_images/mActionToggleEditing.png
https://docs.qgis.org/2.18/en/_images/mActionCalculateField.png
https://docs.qgis.org/2.18/en/_images/checkbox.png
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 You can now find a new field area in the attribute table. 

IV. Configuring the columns 

Right-click in a column header when in table view to have access to tools that help you configure 

what can be displayed in the attribute table and how. 

Hiding and organizing columns and enabling actions 

By right-clicking in a column header, you can choose to hide it from the attribute table. To 

change several columns behavior at once, unhide a column or change the order of the columns, 

choose Organize columns. 

In the new dialog, you can: 

 Check/uncheck columns you want to show or hide 

 Drag-and-drop items to reorder the columns in the attribute table. Note that this change is 

for the table rendering and does not alter the fields order in the layer datasource 

 Enable a new virtual actions column that displays in each row a drop-down box or button 

list of actions for each row, see actions properties for more information about actions. 

https://docs.qgis.org/3.4/en/docs/user_manual/working_with_vector/attribute_table.html#id19
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Resizing columns widths 

Column’s width can be set through a right-click on the column header and select either: 

 Set width… to enter the desired value. By default, the current value is displayed in the 

widget 

 Auto size to resize at the best fit the column. 

 

It can also be changed by dragging the boundary on the right of the column heading. The new 

size of the column is maintained for the layer, and restored at the next opening of the attribute 

table. 

Sorting columns 

The table can be sorted by any column, by clicking on the column header. A small arrow 

indicates the sort order (downward pointing means descending values from the top row down, 

upward pointing means ascending values from the top row down). You can also choose to sort 

the rows with the sort option of the column header context menu and write an expression, e.g. to 

sort the row using multiple columns. 
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Self-Check 2 Written test 

 

Name……………………………………………   ID………………………… Date……. 

Directions:  Answer all the questions listed below.  

1. Test I: Short Answer Questions  

1. Define scanning. List and discuss the steps that can be taken to scan and prepare maps. 

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 

 

2. Define filed registration forms.   

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------- 

3. How to managing point data in different formats and uploading? -----------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------ 
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Operation Sheet -2 

 

2.1.  Techniques/Procedures/Methods of scan field maps.   

A. Tools and equipment 

I. PC/desktop. 

II. Field Map 

III. Scanner with scanning software  

B. Procedures/Steps/Techniques for scan field maps. 

1. Prepare the maps: Before scanning, the paper maps need to be prepared for digitization. 

This involves removing any folds, creases, or tears that might obstruct the scanning 

process.  

2. Choose the appropriate scanner:  select the appropriate scanner for the job.  

3. Set the scanning parameters: This includes selecting the appropriate resolution, color 

mode, and file format. The resolution will depend on the desired level of detail and the 

intended use of the digital map. 

4. Scan the maps: With the scanning parameters set, the maps can be scanned. This involves 

placing the maps on the scanner bed and starting the scanning process.  

5. Clean up the scanned images: After scanning, the digital images may need to be cleaned 

up. This involves removing any unwanted artifacts or blemishes that may have been 

introduced during the scanning process. 
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2.2. Techniques/Procedures/Methods of Georeference    

A. Tools and equipment 

I. PC/desktop. 

II. Scanned field map 

B. Procedures/Steps/Techniques of Georeference  . 

1. Load the image to be georeferenced into QGIS by going to the "Layer" menu and 

choosing "Add Layer" > "Add Raster Layer." 

2. Load a reference layer into QGIS that contains geographic information that you can use 

to align the image. This could be a map, satellite imagery, or any other layer that has 

known geographic coordinates. To load the reference layer, go to the "Layer" menu and 

choose "Add Layer" > "Add Raster Layer" or "Add Vector Layer." 

3. Make sure that the reference layer and the image to be georeferenced are in the same 

coordinate system. If not, you will need to reproject one of them. To do this, right-click 

on the layer and choose "Export" > "Save As" and choose the desired coordinate system. 

4. Open the Georeferencer plugin by going to the "Raster" menu and choosing 

"Georeferencer" > "Georeferencer." 

5. Load the image to be georeferenced by clicking the "Open raster" button and selecting 

the image file. 

6. Add control points to the image by clicking the "Add point" button and clicking on a 

location on the image that corresponds to a known location on the reference layer. Repeat 

this step for several points. 

7. Enter the known coordinates for each control point by clicking on the 

correspondinglocation on the reference layer and entering the coordinates in the "Map X" 

and "Map Y" fields. 

8. Click "OK" to save the control points and close the "Add Control Points" window. 

9. Click the "Play" button to start the georeferencing process. QGIS will use the control 

points to create a transformation that will align the image with the reference layer. 

10. Once the georeferencing process is complete, save the georeferenced image by going to 

the "File" menu and choosing "Save As" and selecting a format that supports 

georeferencing information, such as GeoTIFF. 
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11. Load the georeferenced image into QGIS by going to the "Layer" menu and choosing 

"Add Layer" > "Add Raster Layer." 

12. Check the alignment of the georeferenced image with the reference layer by turning the 

layers on and off and zooming in and out. 

 

2.3. Techniques/Procedures/Methods of Digitizing     

A. Tools and equipment 

I. PC/desktop. 

II. Georeferenced map 

B. Procedures/Steps/Techniques for Digitizing. 

1. Add georeferenced field maps on QGIS.  

2. Load the layer you want to digitize into QGIS by going to the "Layer" menu and 

choosing "Add Layer" > "Add Vector Layer." 

3. Create a new layer for the digitized feature by going to the "Layer" menu, choosing 

"Create Layer" > "New Shapefile Layer" and filling out the necessary information such 

as the name, geometry type, and coordinate reference system. 

4. Enable editing on the new layer by selecting it from the Layers Panel and clicking the 

"Toggle Editing" button on the toolbar or going to the "Layer" menu and choosing 

"Toggle Editing." 

5. Select the appropriate digitizing tool from the toolbar. For example, if you want to draw a 

line feature, select the "Add Line Feature" tool. 

6. Start digitizing by clicking on the map canvas to add vertices to the feature. You can add 

as many vertices as needed to create the desired shape. 

7. To finish the feature, right-click and choose "Finish Sketch" or press the "Enter" key. The 

feature will be added to the layer and the digitizing tool will be deactivated. 

8. Save the edits by going to the "Layer" menu and choosing "Save Edits" or clicking the 

"Save Edits" button on the toolbar. 

9. Continue digitizing additional features as needed by selecting the appropriate digitizing 

tool and repeating the process. 
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10. Once you have finished digitizing all the necessary features, save the layer by going to 

the "Layer" menu and choosing "Save As" to save the layer in a desired format. 

Note that the digitizing process may vary slightly depending on the type of feature you are digitizing and 

the version of QGIS you are using. In addition, it is important to ensure that the digitized features are 

accurate and properly aligned with any reference layers or datasets, and to follow good digitizing 

practices such as minimizing the number of vertices and ensuring that features are properly snapped to 

existing features. 

 

 

LAP Test-2 Performance Test 

 

Name……………………………….           ID……………………………..                                                     

Date……………………………………. 

 

Time started: ________________________ Time finished:  ________________ 

 

Instructions: Given necessary templates, tools and materials you are required to perform the 

following tasks within 2 hour. The project is expected from each student to do 

it. 

 

Task-1:  Scan field maps. 

Task-2:  Georeference    

Task-3:  Digitizing 
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LG #35 LO #3- Solve problems using GIS 

software 
 

Instruction Sheet 3 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Integration of existing spatial data with new data  

 Combining spatial layers data  

 Spatial overlay techniques  

 Integrating cartography principles 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Integrate existing spatial data with new data  

 Combine spatial layers data  

 Identify Spatial overlay techniques  

 Integrate cartography 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below. 

3. Read the information written in the information Sheets 

4. Accomplish the Self-checks  

5. Perform Operation Sheets 

6. Do the “LAP test”  
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3.1.  Integration of existing spatial data with new data  

Spatial data integration is the process of combining multiple spatial data types and providing for 

their storage, retrieval, analysis, and display. The goal of spatial data integration is to facilitate 

the analysis, reasoning, querying, or visualization of the integrated spatial data. Automated 

procedures to support data integration are related to spatial data characteristics, software features, 

and hardware capabilities. Existing spatial data can be integrated with new spatial data and 

attribute data. However, data format, projection and size of the integrated data should be 

considered. Integrating existing spatial data with new data is an essential step in many geospatial 

analysis workflows. This integration allows analysts to combine and analyze data from different 

sources and helps to create a more comprehensive understanding of the spatial relationships and 

patterns. There are several methods for integrating existing spatial data with new data, including: 

1. Spatial Join: Spatial Join involves combining two or more datasets based on their spatial 

relationships. This technique is used when data from multiple sources has a common 

geographic identifier, such as a zip code or a street address. 

2. Overlay Analysis: Overlay Analysis involves overlaying datasets on top of each other to 

identify areas of overlap or intersection. This technique is used when datasets do not have 

a common geographic identifier but share a common spatial extent, such as land use and 

population data. 

3. Data Conversion: Data Conversion involves converting data from one format to another 

to facilitate integration. This technique is useful when data is in a format that is not 

compatible with the analysis software or when data needs to be standardized before 

integration. 

4. Data Fusion: Data Fusion involves combining data from multiple sources to create a new 

dataset that includes information from all sources. This technique is useful when the data 

from different sources provides complementary information about a particular 

phenomenon. 

Information Sheet 3 
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5. Machine Learning: Machine Learning involves using algorithms to identify patterns in 

data and make predictions about future outcomes. This technique is useful when large 

amounts of data need to be analyzed and when the relationships between variables are 

complex. 

Regardless of the method used, integrating existing spatial data with new data requires careful 

consideration of the quality and accuracy of the data. It is important to assess the completeness, 

consistency, and reliability of the data before integrating it to ensure that the resulting analysis is 

accurate and meaningful. Additionally, it is essential to document the data integration process 

thoroughly to ensure that the analysis is reproducible and transparent. 

3.2. Geospatial techniques 

Geospatial techniques refer to a set of methods and tools used to analyze and visualize 

geographic data. These techniques combine various aspects of geography, geology, cartography, 

and computer science to provide insights into spatial relationships, patterns, and trends. Some 

common geospatial techniques include: 

1. Geographic Information System (GIS): GIS is a computer-based system that captures, 

stores, analyzes, and manages geographic data. It allows users to create maps, analyze 

spatial data, and perform complex queries on large datasets. 

2. Remote Sensing: Remote sensing involves the use of sensors, such as satellite imagery, 

to gather information about the earth's surface. This technique is used to monitor changes 

in land use, vegetation, and other environmental factors. 

3. Global Positioning System (GPS): GPS is a satellite-based navigation system that 

allows users to determine their exact location on earth. It is widely used for mapping, 

surveying, and navigation purposes. 

4. Spatial Analysis: Spatial analysis involves the use of statistical techniques to analyze 

geographic data. It is used to identify spatial patterns, relationships, and trends. 

5. Spatial Modeling: Spatial modeling involves the use of mathematical models to simulate 

and predict spatial phenomena. It is used to model environmental processes, such as 

groundwater flow, air pollution, and climate change. 
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6. Cartography: Cartography is the art and science of map making. It involves the design, 

production, and interpretation of maps and other geographic visualizations. 

Geospatial techniques are used in a wide range of fields, including urban planning, 

environmental management, natural resource management, public health, transportation 

planning, and many others. They are especially useful for analyzing large datasets that have a 

geographic component, such as satellite imagery, weather data, and demographic data. With the 

increasing availability of spatial data and advances in geospatial technology, geospatial 

techniques have become an increasingly important tool for decision-making and problem-solving 

in many fields. 

 

3.3.  Spatial overlay techniques  

Spatial overlay techniques involve combining two or more spatial datasets to create a new 

dataset that incorporates information from both sources. Overlay analysis is a powerful 

geospatial technique that can be used to identify the spatial relationships between different 

datasets and to create new insights into geographic phenomena. Some common spatial overlay 

techniques include: 

1. Intersection: Intersection is a spatial overlay technique that involves identifying the 

areas where two or more datasets overlap. This technique is useful when the datasets 

have a common spatial extent and provide complementary information about a particular 

phenomenon. 

2. Union: Union is a spatial overlay technique that combines the features from two or more 

datasets into a new dataset. This technique is useful when the datasets have different 

spatial extents and provide information about different aspects of a phenomenon. 

3. Clip: Clip is a spatial overlay technique that involves extracting a subset of a dataset that 

falls within the spatial extent of another dataset. This technique is useful when the 

datasets have different spatial extents, and the analysis is focused on a specific area of 

interest. 

4. Erase: Erase is a spatial overlay technique that removes the features from one dataset 

that overlap with another dataset. This technique is useful when the analysis is focused on 
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a specific area of interest, and the features outside of that area are not relevant to the 

analysis. 

5. Buffer: Buffer is a spatial overlay technique that involves creating a zone of a specified 

distance around a feature or set of features. This technique is useful when the analysis is 

focused on the proximity of features within a specific area. 

6. Dissolve: Dissolve is a spatial overlay technique that involves combining adjacent 

features that share a common attribute value. This technique is useful when the analysis 

is focused on the aggregation of features with similar attributes. 

7. Identity: Identity is a spatial overlay technique that combines the attributes of two 

datasets based on their spatial relationship. This technique is useful when the datasets 

have a common spatial extent and provide complementary information about a particular 

phenomenon. 

8. Overlay Analysis with Raster Data: Overlay analysis can also be performed with raster 

data, which is used to represent continuous surface data such as elevation or temperature. 

Techniques such as map algebra and zonal statistics can be used to perform overlay 

analysis with raster data. 

Spatial overlay techniques are used in a wide range of fields, including urban planning, 

environmental management, natural resource management, public health, transportation 

planning, and many others. They allow analysts to combine and analyze data from different 

sources and to create a more comprehensive understanding of the spatial relationships and 

patterns. 

3.4. Cartographic integrity and validation    

Cartography is the study and practice of making and using maps. It combines science, aesthetics 

and technique, and builds on the premise that reality (or an imagined reality) can be modeled in 

ways that communicate spatial information effectively. Cartography is the art and science of 

graphically representing a geographical area, usually on a flat surface such as a map or chart. It is 

at the forefront of the development of geospatial data, GIS, GI Science, geospatial standards, 

visualization, generalization, and related topics. Digitized paper maps transformed map data and 

map design into new types of databases.  
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Cartographic integrity and quality assurance are important components of producing high-quality 

maps that accurately represent the data being presented. The following are some steps that can be 

taken to ensure cartographic integrity and quality assurance: 

 

1.  Data Quality: The first step in ensuring cartographic integrity and quality assurance is 

to ensure that the data being used to create the map is of high quality. This may involve 

verifying data accuracy, completeness, and consistency. 

2. Map Design: The design of the map should be carefully considered to ensure that it is 

visually appealing and easy to read. This may involve using appropriate colors, fonts, and 

symbology to represent the data being presented. 

3. Scale: The scale of the map should be appropriate for the level of detail being presented. 

A map that is too small or too large can make it difficult for users to interpret the data. 

4. Labeling: Labels should be clear and easy to read, and should accurately represent the 

data being presented. It is important to avoid crowding labels or using labels that are too 

small to read. 

5. Legend: The legend should be clear and easy to understand, and should accurately 

represent the data being presented. It should include all necessary information about the 

data being presented, including units of measurement and any relevant symbols or colors. 

6. Quality Assurance: Quality assurance is an important component of ensuring 

cartographic integrity. This may involve having multiple people review the map to 

identify any errors or inconsistencies. 

7. Testing: The map should be tested to ensure that it is accurate and effective. This may 

involve testing the map with a sample of users to ensure that it is easy to read and 

understand, and that it effectively communicates the data being presented. 

8. Documentation: Documentation is an important component of ensuring cartographic 

integrity and quality assurance. This may involve creating metadata, user manuals, and 

other documentation that accurately describe the map and the data being presented. 

9. Maintenance: Maintaining the map over time is also important for ensuring cartographic 

integrity and quality assurance. This may involve updating the map as new data becomes 

available or making changes to the map to improve its accuracy or effectiveness. 
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Mostly, ensuring cartographic integrity and quality assurance is an important component of 

producing high-quality maps that accurately represent the data being presented. By following 

best practices for data quality, map design, labeling, legend creation, quality assurance, testing, 

documentation, and maintenance, organizations can produce maps that are accurate, effective, 

and useful for a variety of purposes. 
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Self-Check – 3 Written test  

Name……………………………………………   ID………………………… Date……. 

Directions:  Answer all the questions listed below.  

Test I: Choose the correct answer  

1. ----- involves combining two or more datasets based on their spatial relationships.  

A. Spatial Join                      C. Data Conversion 

B. Overlay Analysis             D.  Machine Learning    

2. ---- is a computer-based system that captures, stores, analyzes, and manages geographic data.   

A. GPS               B. Surveying       C. Demarcation        D.  Database  

3. -------is the art and science of map making. 

A. Map    B.    Cartography   C.   Scale  

Test II: Short Answer Questions 

1. Discuss the steps that can be taken to ensure cartographic integrity and quality assurance. 

-------------------------------------------------------------------------------------------------------------------------------

------------------------------------------------------------------------------------------------------------------------------- 

------------------------------------------------------------------------------------------------------------------------------- 

2. Discuss Geospatial techniques.  

-------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------------- 

3. List and explain Spatial overlay techniques.  

-------------------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------------------- 
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Operation Sheet -3 

 

3.1. Techniques/Procedures/Methods of Spatial overlay techniques (example clip and split).  

A. Tools and equipment 

C. PC/desktop. 

D. Shapefile  

E. QGIS software. 

B. Procedures/Steps/Techniques for clip  

1. Open QGIS and add the shapefile you want to clip, as well as the shapefile that will be 

used as the clip boundary. 

2. Make sure the layers are properly aligned by checking that they have the same coordinate 

system and projection. If not, you may need to re-project one or both of the layers. 

3. Select the shapefile you want to clip in the Layers panel. 

4. Click on the "Clip" tool in the toolbar, which looks like a pair of scissors cutting a line. 

5. In the Clip dialog box, choose the layer that will be used as the clip boundary. This can 

be another shapefile, or a polygon layer you create in QGIS. 

6. Choose a name and location for the clipped shapefile, and click "OK". 

7. QGIS will create a new shapefile that includes only the features from the original 

shapefile that are within the boundary of the clip layer. 

8. You can now save the clipped shapefile as a new file, or continue to work with it in 

QGIS. 
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C. Procedures/Steps/Techniques for split.  

1. Open QGIS and add the shapefile you want to split. 

2. Select the shapefile in the Layers panel. 

3. Click on the "Split Features" tool in the toolbar, which looks like a pair of scissors with 

two overlapping squares. 

4. In the Split Features dialog box, choose the layer that will be used to split the shapefile. 

This can be another shapefile, or a polygon layer you create in QGIS. 

5. Choose a name and location for the split shapefiles, and click "OK". 

6. QGIS will create a new shapefile for each feature in the split layer that intersects the 

original shapefile. Each new shapefile will contain only the features from the original 

shapefile that intersect with the corresponding feature in the split layer. 

7. You can now save the split shapefiles as new files, or continue to work with them in 

QGIS. 
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LAP Test-3 Performance Test 

 

Name……………………………….           ID……………………………..                                                     

Date……………………………………. 

 

Time started: ________________________ Time finished:  ________________ 

 

Instructions: Given necessary templates, tools and materials you are required to perform the 

following tasks within 2 hour. The project is expected from each student to do 

it. 

 

Task-3:  Apply spatial overlay techniques (example clip and split). 
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LG #36 LO #4- GIS software to query spatial data 

 

Instruction Sheet 4 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Accessing, reading, interpreting and editing spatial data 

 Entities and attributes query 

 Presenting spatial data using results from queries 

 Appling entities and attributes queries 

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Access, read, interpret and edit spatial data 

 Entities and attributes queries. 

 Present spatial data using results from queries. 

 Apply entities and attributes queries on un-variants statistics 

Learning Instructions:  

1. Read the specific objectives of this Learning Guide.  

2. Follow the instructions described below. 

3. Read the information written in the information Sheets 

4. Accomplish the Self-checks  

5. Perform Operation Sheets 

6. Do the “LAP test”  
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4.1. Accessing, reading, interpreting and editing spatial data 

Accessing, reading, interpreting, and editing spatial data involve a number of steps and require 

the use of specialized tools and software. Here is a general overview of the process: 

 

1. Accessing spatial data: Spatial data can be accessed from a variety of sources, including 

online databases, government agencies, private companies, and research institutions. 

Some common types of spatial data include digital maps, satellite imagery, aerial photos, 

GPS data, and geospatial databases. To access spatial data, you may need to obtain 

permissions or licenses, or use specialized software to download or retrieve the data. 

2. Reading spatial data: Once you have accessed the spatial data, you will need to use a 

software tool that can read and interpret the data. Some common software tools for 

reading spatial data include GIS software like ArcGIS or QGIS, programming languages 

like Python or R, or specialized file formats like GeoJSON or Shapefiles. The software 

tool you use will depend on the type of data you are working with and the specific 

requirements of your project. 

3. Interpreting spatial data: After you have read the spatial data, you will need to interpret 

the data to gain insights and understand the underlying patterns and relationships. This 

may involve performing spatial analysis, such as calculating distances or areas, 

identifying patterns or trends, or performing spatial joins or overlays. You may also need 

to visualize the data using maps, charts, or graphs to better understand the spatial 

relationships and patterns in the data. 

4. Editing spatial data: Once you have interpreted the spatial data, you may need to edit or 

modify the data to meet the specific requirements of your project. This may involve 

adding new features or attributes, correcting errors or inconsistencies, or merging or 

splitting existing features. To edit spatial data, you will need to use a software tool that 

supports editing capabilities, such as GIS software like ArcGIS or QGIS. 

Information Sheet 4 
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Overall, accessing, reading, interpreting, and editing spatial data requires a combination of 

technical skills, domain knowledge, and familiarity with specialized software tools. By 

following a systematic and data-driven approach, and using the appropriate tools and techniques, 

you can effectively work with spatial data and generate insights that can inform decision-making 

and improve outcomes. 

 

4.2. Entities and attributes  

4.2.1. Entities 

An entity is an object that exists in a real-world and can be easily distinguished among all other 

objects of real-world. It represents a thing that can exist independently and that can be identified 

uniquely. More specifically, an entity often represents a class, group or category of similar 

objects. Most often, an entity represents a real world object such as a car or an employee. Entities 

can be thought of as nouns that come up during the description of the problem to be solved. 

Entities are represented as tables in relational databases. In general, each entity will map to 

exactly one table in the database. Individual rows in the tables correspond to the actual instances 

of the object/thing represented by the entity. For example, in an Employee database, each row 

corresponds to records of individual employees of the company. 

4.2.2. Attributes  

The attributes define the characteristics or the properties of an entity on the basis of which it is 

easily distinguishable among other entities of the real-world. In the entity-relationship modeling, 

properties of entities are called attributes. In other words, attributes represent a sub group of 

information of the object represented by the entity. Attributes define the individual instances and 

help to differentiate between each instance by describing their characteristic. It is important to 

note that attributes cannot be set-valued and they should be atomic. In relational databases, 

where entities are realized as tables, each column represents the attributes of these entities. For 

example, in the Employee table, columns such as department, rank and salary are examples of 

attributes of the employees. In order to differentiate between individual instances of the entity, 
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one or more attribute fields with unique values (for all instances) can be selected as a key. For 

example, the social security number attribute (which is unique for all employees) is often used as 

the primary key of an Employee table. Sometimes multiple attributes can make up the primary 

key as well. 

4.3. Entities and attributes query 

4.3.1. Entities query  

An entities query is a type of query that retrieves information about entities, which are typically 

real-world objects or concepts that are represented in a database or dataset. Entities can be 

people, places, things, or events, and are often associated with specific attributes or properties 

that describe their characteristics or attributes. In a database context, an entities query might 

involve retrieving data about customers, products, orders, or other types of entities that are 

relevant to a particular application or business process. For example, an entities query might 

retrieve information about all customers who have made a purchase in the last month, or all 

products that have been sold in a particular region. 

Entities queries can be executed using a variety of tools and technologies, including SQL, 

NoSQL databases, or specialized database management systems like MongoDB or Elasticsearch. 

The specific syntax and structure of an entities query will depend on the data model and query 

language being used, as well as the specific requirements of the application or business process. 

Some common features of entities queries include: 

 Filtering: Entities queries often involve filtering the data based on specific criteria or 

attributes. For example, a query might retrieve all customers who live in a particular zip 

code, or all products that have a price greater than a certain amount. 

 

 Sorting: Entities queries can also involve sorting the data based on one or more 

attributes. For example, a query might sort customers by their purchase history, or 

products by their price or popularity. 

 Aggregation: Entities queries can also involve aggregating or summarizingdata about 
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entities, such as calculating the total sales for a particular product or the average age of 

all customers in a particular region. 

 Joins: Entities queries may involve joining data from multiple tables or datasets to 

retrieve information about related entities. For example, a query might retrieve all orders 

for a particular customer or all products sold by a particular supplier. 

 

The entity queries differ from SQL queries by allowing the use of geometry data types such as 

points, lines and polygons and it consider the spatial relationship between these geometries. It is 

a set of spatial conditions characterized by spatial operators that form the basis for the retrieval 

of spatial information from a spatial database system. The query expressed as a combination of 

spatial conditions (For example, spatial selection, Abrahamo woredas road is selected from 

assosa zone road) for extracting specific information from a large amount of spatial data without 

actually changing these data. 

 

Figure 4. 1. Spatial query 

Entities queries play an important role in retrieving and analyzing data about real-world objects 

or concepts, and can be used to support a wide range of applications and business processes. By 

using the appropriate query language and tools, and following a systematic and data-driven 

approach, entities queries can help organizations make better decisions and improve outcomes. 
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4.3.2. Attribute Query 

Attribute queries are an extremely common GIS spatial operation. Attribute queries select a 

subset of records based on values of specific attributes. Each attribute query must specify three 

things: an attribute field, a set algebra operator, and an attribute value. For example, if we had a 

data set of land parcels for sale and interested in selecting parcels that are at least six hundred 

km2 areas, our attribute query would be: 

 

Figure 4. 2. Attribute query 

Where ‘Area’ is the attribute field, ‘greater than’ is the set algebra operator, and ‘six hundred’ is 

the attribute value we wish to evaluate. Attribute queries can also select records based on 

multiple attributes combined together using Boolean operators, such as ‘and’, ‘or’, and ‘not’. 
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4.4. Presenting spatial data using results from queries 

Spatial data can be presented in various ways depending on the type of data and the purpose of 

the presentation. One common way to present spatial data is by using maps. Maps are useful for 

visualizing spatial patterns and relationships, and can be created using a variety of software tools, 

such as ArcGIS, QGIS, or Google Maps. To present spatial data using results from queries, you 

could use a tool like SQL Server Management Studio (SSMS) or PostgreSQL to run spatial 

queries on your data. Once you have obtained the results of your query, you can use the output to 

create a map or other visual representation of the data. 

 

For example, if you have a database of customer locations and you want to visualize which 

customers are within a certain distance of a particular store location, you could use a spatial 

query to retrieve all customer locations within a certain radius of the store. You could then use 

the output of the query to create a map that shows the location of the store and the nearby 

customers. Another way to present spatial data is by using charts or graphs. For example, if you 

have data on the population of different cities or regions, you could create a map that shows the 

population density of each area. Alternatively, you could create a bar chart or pie chart that 

shows the population of each city or region. 

 

In general, the choice of how to present spatial data using results from queries depends on the 

type of data and the purpose of the presentation. Maps, charts, and graphs are all useful tools for 

visualizing spatial data, and the output of spatial queries can be used to create these visual 

representations. It is important to choose the most appropriate type of visualization for your data 

and to ensure that the presentation effectively conveys the information you want to 

communicate. 
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4.5. Uni-variate statistics for entity and attribute queries  

Uni-variate statistics are a type of statistical analysis that involves examining a single variable at 

a time. In the context of geospatial data analysis, uni-variate statistics can be used to perform 

entity and attribute queries. Entity queries involve analyzing the spatial distribution of a 

particular feature or entity, such as the number of hospitals in a given area. Attribute queries 

involve analyzing the characteristics of a particular attribute or variable, such as the average 

income of residents in a particular neighborhood. Some common uni-variate statistics used in 

entity and attribute queries include: 

1. Count: Count is a simple uni-variate statistic that involves counting the number of features 

with a particular attribute value or within a particular spatial area. 

2. Mean: Mean is a uni-variate statistic that involves calculating the average value of a 

particular attribute or variable. 

3. Median: Median is a uni-variate statistic that involves identifying the middle value of a set 

of data. It is useful for identifying the central tendency of a distribution when the data is 

skewed or contains outliers. 

4. Mode: Mode is a uni-variate statistic that involves identifying the most common value or 

attribute within a dataset. 

5. Range: Range is a uni-variate statistic that involves identifying the minimum and maximum 

values of a particular attribute or variable. 

6. Standard Deviation: Standard Deviation is a uni-variate statistic that involves measuring the 

amount of variation or dispersion within a dataset. It is useful for assessing the spread of data 

around the mean. 

 

Uni-variate statistics are useful for summarizing and understanding the distribution of data 

within a particular geographic area or feature. They can be used to identify patterns and trends 

within the data and to make comparisons across different areas or features. For example, uni-

variate statistics can be used to compare the average income of residents in different 

neighborhoods or to analyze the distribution of different types of land use within a city. 
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Uni-variate statistics can be calculated using a variety of software tools, including statistical 

software packages such as R or Python, as well as specialized geospatial software such as 

ArcGIS or QGIS. These tools allow users to perform complex statistical analysis on large 

datasets, including geospatial data, and to create maps and visualizations that help to 

communicate the results of the analysis. 

In summary, uni-variate statistics are a useful tool for performing entity and attribute queries on 

geospatial data. By summarizing and analyzing data on a single variable at a time, they allow 

analysts to gain insights into the spatial distribution of features and attributes and to identify 

patterns and trends within the data. 

 

4.6. Solving routine spatial data problems or irregularities 

Routine spatial data problems or irregularities can be solved using a variety of techniques and 

tools, depending on the specific problem at hand. Some common methods for solving spatial data 

problems include: 

I. Data cleaning and preprocessing:  

This involves identifying and correcting errors or inconsistencies in the spatial data, such as 

missing or duplicate values, incorrect or incomplete data, or data in the wrong format. Tools such 

as GIS software, Python libraries like pandas and geopandas, or SQL can be used for data 

cleaning and preprocessing. 

II. Spatial analysis: 

 This involves using spatial data to answer specific questions or solve problems, such as 

identifying patterns or trends, calculating distances or areas, or performing spatial joins or 

overlays. Tools such as GIS software, Python libraries like geopandas, or SQL can be used 

for spatial analysis. 

III. Spatial interpolation:  

This involves estimating values for locations where data is missing or incomplete, based on 

surrounding values or other spatial patterns in the data. Techniques such as kriging, IDW, or 

spline interpolation can be used for spatial interpolation, depending on the nature of the data and 
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the problem at hand. 

IV.  Spatial regression: 

 This involves using spatial data to model relationships between variables and predicts outcomes, 

such as modeling the relationship between land use and property values. Tools such as GIS 

software, Python libraries like pysal, or statistical software like R can be used for spatial 

regression. 

V. Spatial data visualization:  

This involves creating visual representations of spatial data to better understand patterns and 

relationships in the data. Tools such as GIS software, Python libraries like matplotlib or folium, 

or web-based tools like Tableau or Mapbox can be used for spatial data visualization.  

In addition to these techniques, it is important to have a good understanding of the underlying 

spatial data and the context in which it was collected. This can help you identify and diagnose 

irregularities or anomalies in the data, and choose the most appropriate methods for solving 

spatial data problems. Overall, solving routine spatial data problems or irregularities requires a 

combination of technical skills, domain knowledge, and problem-solving skills. By using the 

appropriate tools and techniques, and taking a systematic and data-driven approach to problem-

solving, you can effectively address spatial data issues and generate insights that can inform 

decision-making and improve outcomes. 
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Self-Check – 4 Written test  

 

Name……………………………………………   ID………………………… Date……. 

 

Directions:  Answer all the questions listed below.  

 

Test I: Short Answer Questions 

1. Discuss the difference between Entities and attributes.   

     -----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------- 

2. Discuss the common methods for solving spatial data problems. 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------- 
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Operation Sheet -4 

 

4.1. Techniques/Procedures/Methods of entities query  

A. Tools and equipment 

I. PC/desktop. 

II. Shapefile  

III. QGIS software. 

 

B. Procedures/Steps/Techniques of entities query  

1.  Load the data: load the spatial data into QGIS. This could involve importing a shapefile, a 

GeoJSON file, a CSV file with xy coordinates, or connecting to a database. To load the data, 

go to the "Layer" menu and select "Add Layer" > "Add Vector Layer", and then select the 

file or database you want to load. 

2. Select the query tool: Once the data is loaded, select the "Select Features by Area or Single 

Click" tool from the toolbar. This tool allows you to select features in a layer based on their 

spatial relationship with other features. 

3.  Choose the target layer: Next, choose the layer that you want to perform the spatial query 

on. This could be the same layer that you loaded in step 1, or a different layer. 

4.  Choose the selection method: There are several selection methods available, depending on 

the type of spatial relationship you want to query. For example, you can select features that 

are within a certain distance of a point, that intersect a polygon, or that are contained within a 

polygon. Choose the appropriate selection method from the toolbar. 

5.  Define the query parameters: Depending on the selection method you choose, you may need 

to define additional query parameters. For example, if you want to select features that are 

within a certain distance of a point, you will need to specify the point and the distance. If you 

want to select features that intersect a polygon, you will need to specify the polygon. 

6.  Run the query: Once you have defined the query parameters, click on the "Select Features" 

button to run the query. QGIS will highlight the selected features in the target layer. 
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7. View the results: Finally, you can view the results of the spatial query by inspecting the 

selected features in the target layer. You can also export the selected features to a new layer 

if you want to perform additional analysis or visualization. 

 

4.2. Techniques/Procedures/Methods of Attribute Query 

 Consolidation of parcels based on land administration legal frameworks.  

A. Tools and equipment 

I. Land administration legal documents (proclamation, regulation, directives) 

II. Applicant’s application letter. 

III. Book of holding 

IV. Parcel map 

V. Applicants index card.  

 

B. Procedures/Steps/Techniques 

1. Load the data: The first step is to load the spatial data into QGIS. This could involve 

importing a shapefile, a GeoJSON file, a CSV file with xy coordinates, or connecting to a 

database. To load the data, go to the "Layer" menu and select "Add Layer" > "Add 

Vector Layer", and then select the file or database you want to load. 

2. Open the attribute table: Once the data is loaded, open the attribute table for the layer you 

want to query. To do this, right-click on the layer in the Layers panel and select "Open 

Attribute Table". 

3. Choose the query tool: In the attribute table, select the "Select features using an 

expression" button from the toolbar. This tool allows you to select features in a layer 

based on their attributes. 

4. Define the query expression: In the expression builder, define the query expression based 

on the attributes you want to query. For example, if you want to select all features where 

the area of parcel >1 hectare or  "population" attribute is greater than 100,000, you would 

enter "population > 100000" in the expression builder. 

5. Test the query: Once you have defined the query expression, test it by clicking on the 
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"Test" button. This will highlight the features in the layer that match the query expression. 

6. Run the query: If the query expression is correct and returns the desired results, click on 

the "Select" button to run the query. QGIS will select the features in the layer that match 

the query expression. 

7. View the results: Finally, you can view the results of the attribute query by inspecting the 

selected features in the layer. You can also export the selected features to a new layer if 

you want to perform additional analysis or visualization. 

 

LAP Test-4 Performance Test 

 

Name……………………………….           ID……………………………..                                                     

Date……………………………………. 

 

Time started: ________________________ Time finished:  ________________ 

 

Instructions: Given necessary templates, tools and materials you are required to perform 

the following tasks within 1 hour. The project is expected from each student to do it. 

 

Task-1: Make an entities query. 

Task-2:  Make an attribute query. 
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LG #37 LO #5- Map production 

 

Instruction Sheet 5 

This learning guide is developed to provide you the necessary information regarding the 

following content coverage and topics: 

 Identifying features on maps   

 Measuring, locating and plotting features  

 Cartographic principles 

 Maps production in a desired quality and quantity 

 Archive and manipulate dataset 

 Creating metadata   

This guide will also assist you to attain the learning outcomes stated in the cover page. 

Specifically, upon completion of this learning guide, you will be able to: 

 Identifying features on maps   

 Measure, locate and plot features using spatial reference systems 

 Apply Cartographic principles 

 Create maps in a desired quality and quantity 

 Archive and manipulate dataset 

 Create metadata   

 Manipulated spatial dataset to be archived.   

 Store new and existing spatial dataset 

Learning Instructions:  

7. Read the specific objectives of this Learning Guide.  

8. Follow the instructions described below. 

9. Read the information written in the information Sheets 

10. Accomplish the Self-checks  

11. Perform Operation Sheets 

12. Do the “LAP test”  
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5.1.   Major elements and features on maps 

Maps are visual representations of spatial information and can contain a variety of elements and 

features depending on the purpose of the map. Here are some of the major elements and features 

you might find on a map: 

 

1. Title: The title of the map provides a brief description of the content and purpose of the 

map. 

2. Legend: The legend explains the meaning of symbols, colors, and other visual elements 

used on the map, making it easier to understand the information being presented. 

3. Scale: The scale indicates the ratio between the size of the map and the actual size of the 

area being depicted, helping to provide context and a sense of proportion. 

4. North arrow: The north arrow indicates the direction of true north, helping to orient the 

map and provide a reference for direction. 

5. Grid lines: Grid lines are lines that divide the map into a series of squares or rectangles, 

providing a system of coordinates that can be used to locate specific features or areas on 

the map. 

6. Insets: Insets are smaller maps or images that are included within the main map to 

provide additional detail or context. 

7. Annotations: Annotations are additional text or graphical elements that are added to the 

map to provide additional information or to highlight specific features and authorized 

bodies.  

The major elements and features on maps are designed to provide a range of information about 

the spatial relationships and patterns within an area, and to help users better understand and 

interpret the information being presented. By using a combination of visual and textual elements, 

maps can effectively convey complex spatial information to a wide range of audiences and 

support a variety of applications and decision-making processes. 

Information Sheet 5 
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5.2.  Spatial reference systems 

Spatial reference systems (SRS) are essential for producing accurate and meaningful maps, as 

they provide a framework for defining the spatial relationships and coordinates of features on the 

map. A spatial reference system defines how features are positioned in space and allows for 

measurements and calculations to be made in a consistent and accurate manner. 

There are two main types of spatial reference systems: geographic coordinate systems (GCS) and 

projected coordinate systems (PCS). 

1. Geographic Coordinate Systems (GCS): A geographic coordinate system is a reference 

system that uses a spherical or ellipsoidal model of the Earth to define locations on the 

Earth's surface. A GCS is defined by its origin, which is typically the center of the Earth, 

and two parameters, latitude and longitude. GCSs are commonly used for global or 

regional maps and are often expressed in units of degrees. 

2. Projected Coordinate Systems (PCS): A projected coordinate system is a reference 

system that uses a two-dimensional Cartesian coordinate system to represent locations on 

a map. A PCS is defined by its origin, which is typically a specific point on the Earth's 

surface, and a projection method, which determines how the three-dimensional Earth is 

projected onto a two-dimensional surface. PCSs are commonly used for local or regional 

maps and allow for more accurate representations of distances and areas. 

 

In addition to coordinate systems, spatial reference systems may also include additional 

parameters such as datum, units of measurement, and map projection parameters. These 

parameters are used to ensure that the map accurately represents the features and spatial 

relationships in the real world. 

To produce maps using spatial reference systems, you will need to use specialized software tools, 

such as GIS (Geographic Information Systems) software. GIS software allows you to define and 

manage spatial reference systems, and to create and manipulate maps based on these systems. 

To create a map using spatial reference systems, you will typically need to follow these steps: 
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1. Define the spatial reference system for the map: This involves selecting the 

appropriate coordinate system and projection method for the area you are mapping, as 

well as specifying any additional parameters required for the map. 

2. Import or create the spatial data for the map: This involves obtaining or creating the 

data that will be used to create the map, such as satellite imagery, digital maps, or 

geospatial data. 

3. Create the map: This involves using the GIS software to create the map based on the 

spatial reference system and the spatial data. You can add labels, symbols, colors, and 

other visual elements to the map to make it more informative and visually appealing. 

4. Export or publish the map: Once the map is created, you can export it to a variety of 

file formats, such as PDF or JPEG, or publish it online using web-based mapping 

platforms like ArcGIS Online or Google Maps. 

In general, spatial reference systems are essential for producing accurate and meaningful maps, 

and GIS software provides a powerful tool for working with these systems and creating high-

quality maps that can support a wide range of applications. 

 

5.3.  Cartographical design principles 

Cartographic design principles are the guidelines and best practices that are used to create 

visually effective and informative maps. These principles are based on scientific research and 

years of practical experience in the field of cartography, and they help to ensure that maps are 

accurate, clear, and easy to interpret. Here are some of the key cartographic design principles: 

1. Simplicity: Maps should be simple and uncluttered, with a clear hierarchy of information 

that guides the viewer's eye to the most important features. 

2. Legibility: Maps should be easy to read and understand, with clear and legible fonts, 

symbols, and colors. 

3. Contrast: Maps should use contrast to highlight important features and to create visual 

interest. This can be achieved through the use of color, size, texture, and other visual 

elements. 

4. Balance: Maps should be balanced in terms of the distribution of information, with a 
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clear focal point and a harmonious distribution of elements. 

5. Unity: Maps should have a unified visual theme that ties together the different elements 

and creates a cohesive overall design. 

6. Proportionality: Maps should accurately represent the proportions of the real-world 

features they depict, while also being easy to read and visually appealing. 

7. Generalization: Maps should generalize complex features or data to make them easier to 

understand, while still preserving their essential characteristics. 

8. Contextualization: Maps should provide context and background information that helps 

viewers understand the spatial relationships and patterns depicted on the map. 

9. Use of visual hierarchy: Maps should use visual hierarchy to clearly distinguish between 

different levels of information and to guide the viewer's eye to the most important 

features. 

10. Use of appropriate color schemes: Maps should use appropriate color schemes that are 

visually appealing, easy to read, and accurately represent the features being depicted. 

11. Use of appropriate symbols and icons: Maps should use appropriate symbols and icons 

that are easily recognizable and convey the intended meaning. 

12. Use of appropriate scales: Maps should use appropriate scales that accurately represent 

the size and relationships of the features being depicted. 

13. Use of appropriate projections: Maps should use appropriate projections that accurately 

represent the spatial relationships of the features being depicted. 

Overall, cartographic design principles are essential for creating maps that are accurate, 

informative, and visually appealing. By following these principles and using appropriate tools 

and techniques, cartographers can create maps that effectively communicate spatial information 

and support a wide range of applications and decision-making processes. 

 

5.4.  Map production in a desired quality and quantity 

Producing land parcel maps in a desired quality and quantity typically involves a combination of 

manual and automated processes, as well as careful attention to data quality and accuracy. The 

following are some steps that can be taken to produce land parcel maps in a desired quality and 
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quantity: 

1. Data Acquisition: The first step in producing land parcel maps is to acquire the 

necessary data. This may involve obtaining data from various sources, such as 

government agencies, surveyors, or private companies. It is important to ensure that the 

data is accurate, complete, and up-to-date. 

2. Data Processing: Once the data is acquired, it may need to be processed to ensure that it 

is suitable for use in the mapping process. This may involve cleaning the data, removing 

duplicates, and standardizing the data format. 

3. Georeferencing: involves aligning the map data to a specific geographic location. This is 

typically done by matching the map data to known geographic coordinates using GPS or 

other geospatial data. 

4. Digitization: Digitization involves converting the map data into a digital format that can 

be used in GIS software. This may involve manually tracing the boundaries of land 

parcels using specialized software, or it may be automated using image recognition 

algorithms. 

5. Quality Control: Once the land parcel maps have been digitized, it is important to 

ensure that the data is accurate and complete. Quality control may involve manually 

checking the boundaries of each parcel against field surveys or other data sources. 

6. Map Production: Once the land parcel maps have been digitized and quality-controlled, 

they can be produced in the desired quality and quantity. This may involve creating maps 

at various scales, producing maps in different formats (such as digital or paper), and 

adding additional information to the maps, such as zoning information or property 

ownership details. 

7. Maintenance: Land parcel maps are subject to change over time, as new parcels are 

created or existing ones are modified. It is important to establish a maintenance schedule 

to ensure that the maps remain accurate and up-to-date. 

To produce land parcel maps in a desired quality and quantity, it is important to have the necessary 

expertise and resources, including GIS software, data acquisition tools, and qualified personnel. 

Additionally, it is important to establish a clear workflow and quality control processes to ensure that the 

maps are accurate and reliable. 



 

Page 88 of 129 

 

Ministry of Labor and Skills 

Author/Copyright 

Rural Land Administration 

Level –III 
Version-1 

May, 2023 

 

 

Overall, producing land parcel maps in a desired quality and quantity requires a combination of careful 

planning, attention to detail, and expertise in geospatial data analysis and mapping techniques. 

 

5.5.  Archived all datasets  

Archiving datasets is an important step in data management to ensure that data is preserved and 

accessible for future use. There are several steps involved in archiving datasets: 

1. Identify the datasets: The first step in archiving datasets is to identify the datasets that need 

to be archived. This may involve reviewing the data inventory and identifying datasets that 

are no longer being actively used, or that are no longer required for current research or 

analysis. 

2. Determine the appropriate archiving method: The next step is to determine the 

appropriate archiving method for the dataset. This may involve selecting a data repository or 

archive, or it may involve creating an archive within the organization's own data storage 

system. 

3. Prepare the data: Before archiving the datasets, it is important to ensure that the data is 

properly formatted and documented. This may involve standardizing the data format, 

creating metadata and documentation files, and removing any sensitive or confidential 

information. 

4. Transfer the data: Once the data is properly prepared, it can be transferred to the archive. 

This may involve uploading the data to a data repository or transferring it to a designated 

network drive or storage location. 

5. Verify the data: After transferring the data, it is important to verify that the data has been 

successfully archived and is accessible for future use. This may involve checking that the 

data can be downloaded and opened, and that it is properly documented and formatted. 

6. Establish access and sharing policies: Finally, it is important to establish access and 

sharing policies forthe archived datasets. This may involve setting permissions for who can 

access the datasets, determining the conditions under which the data can be shared, and 

establishing protocols for how the data can be used and cited. 
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Archiving datasets is an important step in data management to ensure that data is preserved and 

accessible for future use. It also allows researchers and analysts to build on existing work and 

contributes to the reproducibility and transparency of research. By following best practices for 

archiving datasets, organizations can ensure that their data remains a valuable resource for future 

research and analysis. 

 

5.6.  Creating metadata   

Metadata is descriptive information about a dataset that provides context and helps users 

understand the dataset and how it was created. Creating metadata for land parcel maps is an 

important step in ensuring that the maps are properly documented and can be used effectively for 

research and analysis. 

The following are some steps that can be taken to create metadata for land parcel maps: 

 

1. Identify the data elements: The first step in creating metadata for land parcel maps is to 

identify the data elements that should be included in the metadata. This may include 

information about the source of the data, the projection and coordinate system used, the date 

the data was created, and any relevant attributes or variables. 

2. Choose a metadata standard: There are several metadata standards that can be used for 

geospatial data, including ISO 19115 and FGDC CSDGM. Choose a standard that is 

appropriate for the type of data being documented and ensure that all required metadata 

elements are included. 

3. Use descriptive language: Use clear, concise, and descriptive language to describe the land 

parcel map and the data it contains. Avoid using technical jargon or acronyms that may be 

unfamiliar to users. 

4. Provide context: Provide context for the land parcel map by describing the purpose of the 

map, the geographic area it covers, and any relevant data sources or processing steps that 

were used to create the map. 

5. Include contact information: Include contact information for the person or organization 

responsible for creating and maintaining the land parcel map, as well as information about 

how users can access the data or obtain further information. 
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6. Document data quality and accuracy: Document the data quality and accuracy of the land 

parcel map by describing any limitations or caveats associated with the data, as well as any 

known errors or uncertainties. 

7. Update metadata: Metadata should be updated regularly to reflect changes to the land parcel 

map or the data it contains. It is important to establish a process for updating metadata and to 

ensure that metadata remains current and accurate. 

Creating metadata for land parcel maps is an important step in ensuring that the maps are 

properly documented and can be used effectively for research and analysis. By providing 

descriptive information about the map and the data it contains, metadata helps users understand 

the context of the data and make informed decisions about its use. 

 

5.7. Required documentation according to organizational policies  

 

Completing land parcel map required documentation according to organizational policies is an important 

step in ensuring that the maps are properly documented and can be used effectively for research and 

analysis. The following are some steps that can be taken to complete land parcel map required 

documentation according to organizational policies: 

1. Review organizational policies: The first step in completing land parcel map required 

documentation is to review the organization's policies and procedures for data 

documentation. This will help to ensure that the documentation is consistent with the 

organization's standards and requirements. 

2. Identify required documentation: Identify the required documentation for the land 

parcel map. This may include metadata, data dictionaries, user manuals, and other 

documentation as required. 

3. Prepare metadata: Create metadata for the land parcel map by using a metadata 

standard that is appropriate for the type of data being documented. Include information 

about the source of the data, the projection and coordinate system used, the date the data 

was created, and any relevant attributes or variables. 

4. Create data dictionaries: Create data dictionaries that provide detailed descriptions of 

the fields in the land parcel map. This will help users understand the meaning of each 
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field and how it should be used. 

5. Prepare user manuals: Prepare user manuals that provide instructions for using the land 

parcel map. This may include information on how to access the data, how to interpret the 

data, and how to use any associated software or tools. 

6. Review and revise documentation: Review the documentation for accuracy, 

completeness, and consistency with organizational policies. Revisethe documentation as 

necessary to ensure that it meets all requirements. 

7. Publish documentation: Publish the completed documentation in a location where it can 

be easily accessed by users. This may include a data repository or a designated network 

drive or storage location. 

8. Update documentation: Documentation should be updated regularly to reflect changes 

to the land parcel map or the data it contains. It is important to establish a process for 

updating documentation and to ensure that the documentation remains current and 

accurate. 
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Self-Check – 5 Written test  

 
Name……………………………………………   ID………………………… Date……. 

 

Directions:  Answer all the questions listed below.  

 

Test I: Short Answer Questions 

1. Define map with the major elements in brief.  

 ----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

----------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------- 

2. What are the types of spatial reference system? 

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

-------------------------------------------------------------------------------------------------------------------- 

3. Discuss metadata.   

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

---------------------------------------------------------------------------------------------------------------------

--------------------------------------------------------------------------------------------------------------------- 
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Operation Sheet -5 

 

5.1.  Techniques/Procedures/Methods of producing Parcel map.  

A. Tools and equipment 

i. Shapefile 

ii. QGIS 

iii. PC/Desktop 

iv. Operational manual  

 

B. Procedures/Steps/Techniques 

1. Collect the data: Importing a shapefile or connecting to a database that contains parcel boundaries 

and attributes. 

2. Load the data: To load a shapefile, go to the "Layer" menu and select "Add Layer" > "Add Vector 

Layer", and then select the shapefile you want to load. If you are connecting to a database, go to 

the "Layer" menu and select "Add Layer" > "Add PostGIS Layers", and then enter the connection 

details. 

3. Symbolize the data: Once the data is loaded, symbolize it so that you can see the parcel 

boundaries and attributes. To do this, right-click on the layer in the Layers panel and select 

"Properties". In the "Symbology" tab, choose the appropriate symbolization method based on the 

data you are working with. 

4. Join the attribute data: If your parcel boundaries and attribute data are in separate layers, you will 

need to join them together. To do this, go to the "Layer" menu and select "Properties". In the 

"Joins" tab, choose the appropriate join type and select the join fields. 

5. Label the parcels: Label the parcels with their attribute values so that you can easily identify them 

on the map. To do this, go to the "Labels" tab in the layer properties and choose the attribute field 

you want to use for labeling. 

6. Add additional layers: If you want to add additional layers to your parcel map, such as roads, 

water bodies, or buildings, you can add them using the "Add Layer" button in the Layers panel. 

7. Add all map elements:  To do this got project and use new print composer and then add item. 

8. Export the map: Once you have finalized the parcel map, you can export it as a PDF, image file, 

or print it directly from QGIS. To export the map, go to the "Project" menu and select "Export 

Map" or "Print". 
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LAP Test-5 
Performance Test 

 

Name……………………………….           ID……………………………..                                                     

Date……………………………………. 

 

Time started: ________________________ Time finished:  ________________ 

 

Instructions: Given necessary templates, tools and materials you are required to perform 

the following tasks within 1 hour. The project is expected from each student to do it. 

 

Task-1: Produce parcel map. 
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